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About This Book

WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily
harm or loss of life.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in
damage to equipment or loss of information.

NOTE: Text set off in this manner provides important supplemental information.
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1 Product Features

Standard Configuration Features
Features may vary depending on the model. For a complete listing of the hardware and software
installed on the computer, run the diagnostic utility (included on some computer models only).

NOTE: This product features optional Powered USB ports. In the retail industry, “Powered USB” is
also referred to as “USB + Power,” “USB Plus Power,” and “Retail USB.” In this document, these
ports are referred to as “Powered USB.”
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Front Panel Components

1 Dual-State Power Button 5 USB Port

2 Power On Light 6 Hard Drive Activity Light

3 NIC Link Light 7 NIC Activity Light

4 Microphone Port 8 Headphone Port

NOTE: The USB, microphone, and headphone ports are located behind a sliding door.

The NIC link light indicates a network connection. The NIC activity light indicates network activity.

The Power On Light is normally green when the power is on. If it is flashing red, there is a problem with the computer
and it is displaying a diagnostic code. Refer to the Maintenance and Service Guide to interpret the code.
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Rear Panel Components

1 Power Cord Connector 8 Cash Drawer Connector

2 Powered USB 24V 9 USB Ports (4)

3 RJ-45 Network Connector 10 Powered USB 12V

4 Expansion Slot Cover 11 VGA Connector

5 Parallel Port 12 DisplayPort

6 PS/2 Mouse Connector (green) 13 PS/2 Keyboard Connector (purple)

7 Serial Connector (COM1) 14 Serial Connector (COM2)

NOTE: Arrangement and number of connectors may vary by model.

The expansion slot can be populated with an optional 2-port serial card or an optional 3-port powered
USB 12V card available from HP.

The serial ports can be configured as 5V or 12V powered serial ports.

CAUTION: You must peel off the metallic tape over the cash drawer connector to connect a cash
drawer. The cash drawer connector is similar in size and shape to a telephone jack. To avoid damage
to the computer, DO NOT plug a telephone cable into the cash drawer connector.

Serial Number Location
Each computer has a unique serial number and product ID number located on the back or side of the
computer. Keep these numbers available for use when contacting customer service for assistance.
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2 Installing and Customizing the
Software

Activating and customizing the software
If your computer was not shipped with a Windows® operating system, some portions of this
documentation do not apply. Additional information is available in online help after you activate the
operating system.

CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully activated. Doing so may cause errors and prevent the operating system from
installing properly.

NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor
to permit the required airflow.

Activating the Windows operating system

The first time you turn on the computer, the operating system is set up and activated automatically.
This process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to
complete the activation.

We recommend that you register your computer with HP during operating system setup so you can
receive important software updates, facilitate support questions, and sign up for special offers.

CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL
THE PROCESS IS COMPLETE. Turning off the computer during the activation process may damage
the software that runs the computer or prevent its proper installation.

NOTE: If the computer shipped with more than one operating system language on the hard drive,
the activation process could take up to 60 minutes.
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Downloading Windows 7 updates

Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.

1. To set up your Internet connection, click Start > Internet Explorer and follow the instructions on
the screen.

2. After an Internet connection has been established, click the Start > All Programs > Windows
Update.

3. Run Windows Update monthly thereafter.

Installing or upgrading device drivers

When installing optional hardware devices after the operating system installation is complete, you
must also install the drivers for each of the devices.

In Windows 7, if prompted for the i386 directory, replace the path specification with C:\i386, or use
the Browse button in the dialog box to locate the i386 folder. This action points the operating system
to the appropriate drivers.

Obtain the latest support software, including support software for the operating system, from
http://www.hp.com/support. Select your country and language, select Download drivers and
software (and firmware), enter the model number of the computer, and press Enter.

Customizing the monitor display

If you wish, you can select or change the monitor refresh rates, screen resolution, color settings, font
sizes, and power management settings.

For more information, refer to the online documentation provided with the graphics controller utility or
the documentation that came with your monitor.

Right-click on the Windows desktop, then click Personalize to change display settings.

Turning off the computer
To properly turn off the computer, first shut down the operating system software.

▲ Click Start  > Shut down.

Finding more information
NOTE: Some or all of the following documents are available on the computer hard drive.

● Getting Started—Helps you connect the computer and peripheral devices and set up factory-
provided software; also includes basic troubleshooting information should you encounter any
problems during initial startup.

● Hardware Reference Guide—Provides an overview of the product hardware, as well as
instructions for upgrading this series of computers; includes information on RTC batteries,
memory, and power supply.

Turning off the computer 5
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● Maintenance and Service Guide (English only)—Provides information on parts removal and
replacement, troubleshooting, Desktop Management, setup utilities, safety, routine care,
connector pin assignments, POST error messages, diagnostic indicator lights and error codes.

● Regulatory, Safety and Environmental Notices—Provides safety and regulatory information that
ensures compliance with U.S., Canadian, and various international regulations.

Accessing User Guides (Linux systems)

Double-click the HP User Manuals icon on your desktop. Select the folder for your language. Select
the guide you wish to access.
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3 Illustrated parts catalog

Computer major components

Item Description Spare part number

(1) System board (includes Intel Celeron 807UE processor; includes replacement thermal
material)

682426-001

(2) Front bezel 682430-001

(3) Power supply, 115W 682435-001

 Access panel (not illustrated) 682429-001

 Memory modules (PC3-12800; not illustrated)  

 8-GB 689374-001

 4-GB 689373-001

 2-GB 689372-001
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Cables

Item Description Spare part number

(1) Front USB and power switch assembly 682432-001

(2) Hard drive power/data cable assembly 682433-001

 Adapter, DisplayPort to VGA (not illustrated) 632484-001

 Adapter, DisplayPort to DVI (not illustrated) 662723-001

 Adapter, DisplayPort to HDMI (not illustrated) 617450-001

 DisplayPort cable (not illustrated) 487562-001
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Misc parts

Item Description Spare part number

(1) Fan assembly 682431-001

(2) Speaker 647447-001

(3) Antenna kit for use with WLAN modules 711789-001

 Cover, powered serial port (not illustrated) 353054-001

 Hard drive grommet (not illustrated) 594220-001

 Rubber feet (not illustrated) 583654-001

 Keyboard (not illustrated)

For a detailed list of available keyboards and their country codes, see Sequential part
number listing on page 11.

 

 PS/2, for use in the United States 674312-xx1

 USB, for use in the United States 674313-xx1

 Washable, for use in the United States 613125-xx1

 Mouse (not illustrated)  

 PS2, optical, jack black 609250-001

 Washable 619580-001

 Optical, jack black 537749-001

 Laser, jack black 570580-001
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Expansion cards

Description Spare part number

Expansion cards  

(1) PCIe to PCIe riser (not illustrated) 711791-001

(2) PCIe to PCI riser 711790-001

(3) 2-port powered serial card 638947-001

(4) Powered USB card – 12V 711788-001

(5) Ralink RT5390R 802.11bgn 1x1 Wi-Fi Adapter (WLAN module) 701396-001

 Atheros AR9462 802.11b/g/n Wi-Fi Adapter (not illustrated) 701398-001

Drives

Description Spare part number

Hard drive  

320-GB, 7200-rpm 639135-001

256-GB Solid-state drive 661842-001

128-GB Solid-state drive 665961-001

32-GB Solid-state drive, MLC 686616-001
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Sequential part number listing

Spare part
number

Description

353054-001 Cover, powered serial port

487562-001 DisplayPort cable

537749-001 Mouse, optical, jack black

570580-001 Mouse, laser, jack black

583654-001 Rubber feet

594220-001 Hard drive grommet

609250-001 Mouse, PS2, optical, jack black

613125-001 Washable keyboard for use in the United States

613125-031 Washable keyboard for use in the United Kingdom

613125-041 Washable keyboard for use in Germany

613125-051 Washable keyboard for use in France

613125-061 Washable keyboard for use in Italy

613125-071 Washable keyboard for use in Spain

613125-081 Washable keyboard for use in Denmark

613125-091 Washable keyboard for use in Norway

613125-101 Washable keyboard for use in Sweden

613125-111 Washable keyboard for use in Switzerland

613125-121 Washable keyboard for use in the French Canada

613125-131 Washable keyboard for use in Portugal

613125-141 Washable keyboard for use in Turkey

613125-151 Washable keyboard for use in Greece

613125-161 Washable keyboard for use in Latin America

613125-171 Washable keyboard for use in Saudi Arabia

613125-181 Washable keyboard for use in Belgium

613125-201 Washable keyboard for use in Brazil

613125-211 Washable keyboard for use in Hungary

613125-221 Washable keyboard for use in the Czech Republic

613125-231 Washable keyboard for use in Slovakia

613125-251 Washable keyboard for use in Russia

613125-261 Washable keyboard for use in Bulgaria

613125-271 Washable keyboard for use in Romania

613125-BB1 Washable keyboard for use in Israel
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Spare part
number

Description

613125-B41 Washable keyboard for use in Slovakia

613125-DE1 Washable keyboard for use in Northwest Africa

613125-L31 Washable keyboard for use internationally

617450-001 Adapter, DisplayPort to HDMI

619580-001 Mouse, washable

632484-001 Adapter, DisplayPort to VGA

638947-001 2-port powered serial card

639135-001 320-GB, 7200 RPM hard drive

647447-001 Speaker

661842-001 256-GB Solid-state drive

662723-001 Adapter, DisplayPort to DVI

665961-001 128-GB Solid-state drive

674312-001 PS/2 keyboard for use in the United States

674312-031 PS/2 keyboard for use in the United Kingdom

674312-041 PS/2 keyboard for use in Germany

674312-051 PS/2 keyboard for use in France

674312-061 PS/2 keyboard for use in Italy

674312-071 PS/2 keyboard for use in Spain

674312-081 PS/2 keyboard for use in Denmark

674312-091 PS/2 keyboard for use in Norway

674312-101 PS/2 keyboard for use in Sweden

674312-111 PS/2 keyboard for use in Switzerland

674312-121 PS/2 keyboard for use in the French Canada

674312-131 PS/2 keyboard for use in Portugal

674312-141 PS/2 keyboard for use in Turkey

674312-151 PS/2 keyboard for use in Greece

674312-161 PS/2 keyboard for use in Latin America

674312-171 PS/2 keyboard for use in Saudi Arabia

674312-181 PS/2 keyboard for use in Belgium

674312-201 PS/2 keyboard for use in Brazil

674312-211 PS/2 keyboard for use in Hungary

674312-221 PS/2 keyboard for use in the Czech Republic

674312-231 PS/2 keyboard for use in Slovakia

674312-251 PS/2 keyboard for use in Russia
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Spare part
number

Description

674312-261 PS/2 keyboard for use in Bulgaria

674312-271 PS/2 keyboard for use in Romania

674312-281 PS/2 keyboard for use in Thailand

674312-291 PS/2 keyboard for use in Japan

674312-AA1 PS/2 keyboard for use in the People's Republic of China

674312-AB1 PS/2 keyboard for use in Taiwan

674312-B41 PS/2 keyboard for use in the BHCSY

674312-BB1 PS/2 keyboard for use in Israel

674312-D61 PS/2 keyboard for use in India

674312-DE1 PS/2 keyboard for use in Northwest Africa

674312-KD1 PS/2 keyboard for use in South Korea

674312-L31 PS/2 keyboard for use internationally

674313-001 USB keyboard for use in the United States

674313-031 USB keyboard for use in the United Kingdom

674313-041 USB keyboard for use in Germany

674313-051 USB keyboard for use in France

674313-061 USB keyboard for use in Italy

674313-071 USB keyboard for use in Spain

674313-081 USB keyboard for use in Denmark

674313-091 USB keyboard for use in Norway

674313-101 USB keyboard for use in Sweden

674313-111 USB keyboard for use in Switzerland

674313-121 USB keyboard for use in the French Canada

674313-131 USB keyboard for use in Portugal

674313-141 USB keyboard for use in Turkey

674313-151 USB keyboard for use in Greece

674313-161 USB keyboard for use in Latin America

674313-171 USB keyboard for use in Saudi Arabia

674313-181 USB keyboard for use in Belgium

674313-201 USB keyboard for use in Brazil

674313-211 USB keyboard for use in Hungary

674313-221 USB keyboard for use in the Czech Republic

674313-231 USB keyboard for use in Slovakia

674313-251 USB keyboard for use in Russia
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Spare part
number

Description

674313-261 USB keyboard for use in Bulgaria

674313-271 USB keyboard for use in Romania

674313-281 USB keyboard for use in Thailand

674313-291 USB keyboard for use in Japan

674313-AA1 USB keyboard for use in the People's Republic of China

674313-AB1 USB keyboard for use in Taiwan

674313-B41 USB keyboard for use in the BHCSY

674313-BB1 USB keyboard for use in Israel

674313-D61 USB keyboard for use in India

674313-DE1 USB keyboard for use in Northwest Africa

674313-KD1 USB keyboard for use in South Korea

674313-L31 USB keyboard for use internationally

682433-001 Hard drive power/data cable assembly

682431-001 Fan assembly

682430-001 Front bezel

682429-001 Access panel

682432-001 Front USB and power switch assembly

682426-001 System board (includes Intel Celeron 807UE processor; includes replacement thermal material)

682435-001 Power supply, 115W

686616-001 32-GB Solid-state drive, MLC

689372-001 Memory module, 2-GB, PC3 12800, 1333-MHz

689373-001 Memory module, 4-GB, PC3 12800, 1333-MHz

689374-001 Memory module, 8-GB, PC3 12800, 1333-MH

711789-001 Antenna kit for use with WLAN modules

711790-001 PCIe to PCI Riser – 24V

711791-001 PCIe to PCIe Riser – 24V

711788-001 Powered USB Card – 12V
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4 Removal and Replacement Procedures

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to
verify that all components operate properly.

NOTE: Not all features listed in this guide are available on all computers.

Preparation for Disassembly
See Identifying the Chassis, Routine Care, and Disassembly Preparation on page 120 for initial
safety procedures.

1. Close any open software applications.

2. Exit the operating system.

3. Remove any compact disc. or media card from the computer.

4. Turn off the computer and any peripheral devices that are connected to it.

5. Disconnect the power cord from the electrical outlet and then from the computer.

CAUTION: Regardless of the power-on state, voltage is always present on the system board
as long as the system is plugged into an active AC outlet. You must disconnect the power cord
to avoid damage to the internal components of the computer.

6. Disconnect all peripheral device cables from the computer.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using
the wrong screw in an application may damage the unit.

Serial Number Location
Each computer has a unique serial number and product ID number located on the back or side of the
computer. Keep these numbers available for use when contacting customer service for assistance.
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Access Panel

Description Spare part number

Access panel 682429-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 15).

2. Loosen the thumbscrew on the rear of the computer (1), slide the access panel toward the rear
of the computer, then lift it off (2).

To install the computer cover, reverse the removal procedure.
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Front Bezel

Description Spare part number

Front bezel 682430-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 15).

2. Remove the access panel (Access Panel on page 16).

3. Lift up the three tabs on the side of the bezel (1), then rotate the bezel off the chassis (2).

To install the front bezel, reverse the removal procedure.

Front Bezel 17



Cable Management
The chassis is a very compact computer and proper routing of the internal cables is critical to the
operation of the computer. Follow good cable management practices when working inside the
computer.

● Keep cables away from major heat sources like heat sinks.

● Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

● Keep cables clear of movable or rotating parts like the power supply and drive cage to prevent
them from being cut or crimped when the component is lowered into its normal position.

● Do not bend any cable sharply. A sharp bend can break the internal wires.

● Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

● Never crease a SATA data cable.

● Do not rely on components like the power supply or computer cover to push cables down into
the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the connectors on the system board, always
follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector.

2. Grasp the cable end of the connector and pull it straight up.

CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could
damage the cable and result in a failed power supply.
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Cable Connections

No. System Board Connector System Board Label Color Component

1 USB MEDIA2 black 12-volt Powered USB Card

2 USB MEDIA1 green 12-volt Powered USB Card

3 Riser Card Socket RPOS RISER white Riser Card

4 Memory Socket DIMM1 black Memory

5 SATA 3.0 SATA0 dark blue Hard Drive

6 Battery Holder BAT black Battery

7 Mini PCI Express x1 X1PCIEXP1 black Expansion Card (for example,
WLAN card)

Cable Management 19



Memory

Description Spare part number

8-GB, PC3-12800 689374-001

4-GB, PC3-12800 689373-001

2-GB, PC3-12800 689372-001

The computer comes with one double data rate 3 synchronous dynamic random access memory
(DDR3-SDRAM) small outline dual inline memory module (SODIMM).

DDR3-SDRAM DIMMs

CAUTION: This product DOES NOT support DDR3 Ultra Low Voltage (DDR3U) memory. The
processor is not compatible with DDR3U memory and if you plug DDR3U memory into the system
board, it can cause the physical damage to the SODIMM or invoke system malfunction.

For proper system operation, the SODIMM must be:

● industry-standard 204-pin

● unbuffered non-ECC PC3-12800 DDR3-1600 MHz-compliant

● 1.5 volt DDR3-SDRAM SODIMMs

The DDR3-SDRAM SODIMM must also:

● support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)

● contain the mandatory Joint Electronic Device Engineering Council (JEDEC) specification

In addition, the computer supports:

● 512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

● single-sided and double-sided SODIMMS

● SODIMMs constructed with x8 and x16 devices; SODIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install an unsupported SODIMM.
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Replacing a SODIMM

CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before removing or installing a memory module. Regardless of the power-on state, voltage is
always supplied to the memory module as long as the computer is plugged into an active AC outlet.
Removing or installing a memory module while voltage is present may cause irreparable damage to
the memory module or system board.

The memory module socket has gold-plated metal contacts. When upgrading the memory, it is
important to use a memory module with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 15).

2. Remove the access panel (Access Panel on page 16).

3. To remove a SODIMM, press outward on the two latches on each side of the SODIMM (1) then
pull the SODIMM out of the socket (2).

The computer automatically recognizes the additional memory when you turn on the computer.

NOTE: A memory module can be installed in only one way. Match the notch on the module with the
tab on the memory socket.
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Expansion Cards

Description Spare part number

PCIe to PCI riser – 24V 711790-001

PCIe to PCIe riser – 24V 711791-001

Powered USB card – 12V 711788-001

2-port powered serial card 638947-001

Atheros AR9462 802.11b/g/n Wi-Fi Adapter 701398-001

Ralink RT5390R 802.11bgn 1x1 Wi-Fi Adapter (WLAN module) 701396-001

One Full-height expansion card can be installed into one of the riser card slots on the computer.

There are two riser cards available from HP for this product. One has a PCI slot and the other has a
PCI Express x1 slot. Both cards have a slot designated for the Powered Serial Port expansion card.

CAUTION: The Powered Serial Port expansion card slot on the riser card looks very similar to a
PCI Express x1 expansion card slot. Do not attempt to insert a PCI Express x1 expansion card into
the Powered Serial Port expansion card slot and do not attempt to insert a Powered Serial Port
expansion card into a PCI Express x1 expansion card slot

No. Expansion Slots

1 PCI Express x1 Expansion Card slot

2 PCI Expansion Card slot

3 Powered Serial Expansion Card slot

NOTE: Although there are two slots in each riser card, you can only install one
expansion card in the riser card.

The bottom slot on each card (3) is designed specifically for an HP Powered Serial Port
expansion card. DO NOT attempt to plug any other type of card into the bottom slot.
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Installing an Optional Powered Serial Port Expansion Card

Two powered serial ports, COM 1 and COM 2, are standard on the computer. Some models have a
powered serial port expansion card installed that supplies two additional powered serial ports, COM 3
and COM 4.

Item Description Supports  

  +5V +12V

1 COM 1 Yes Yes

2 COM 2 Yes Yes

3 COM 3 (optional) Yes Yes

4 COM 4 (optional) Yes Yes

NOTE: The powered serial ports are configured for power in the
Computer Setup utility. Refer to Configuring Powered Serial Ports
on page 25 for more information.

CAUTION: Be careful when connecting peripheral devices to powered 5V and 12V serial ports. The
peripheral device must require the same voltage for which the powered serial port is configured.
Connecting a peripheral device that is not rated for the same voltage supplied by the powered serial
port can damage the computer and the peripheral device.

If the powered serial ports have been configured for power from the factory, they will be covered by
protective plastic caps. Turn off the computer and remove the caps before connecting powered serial
devices.

To install a Powered Serial Port expansion card:

NOTE: The following procedure provides instructions for installing a Powered Serial Port expansion
card. However, the procedure is basically the same for installing any full-height PCI expansion card or
PC Express x1 expansion card.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 15).

2. Remove the access panel (Access Panel on page 16).
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3. Push outward on the tab located on the back of the expansion card retention latch inside the
chassis (1) and rotate the latch open (2).

4. Before installing the expansion card, remove the expansion slot cover by sliding it out of the slot
on the rear of the chassis.
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5. Install the Powered Serial Port expansion card into the bottom socket on the riser card. Move the
card toward the rear of the chassis so that the bracket on the card is aligned with the open slot
on the rear of the chassis (1). Press the card straight down into the expansion socket on the
riser card (2).

NOTE: The Powered Serial Port expansion card must be installed in the bottom socket on the
riser card. The bottom socket is designed specifically for that card. DO NOT attempt to install
any other card in the bottom socket.

Configuring Powered Serial Ports

The serial ports can be configured as standard (non-powered) serial ports or powered serial ports.
Some devices use a powered serial port. If the serial port is configured as a powered port, devices
that support a powered serial interface do not require an external power source.

NOTE: The computer ships with all serial ports configured in standard serial mode by default unless
the powered serial port AV numbers are ordered.

The serial ports can be configured using the Computer F10 Setup utility. Under the Onboard
Devices menu, you are given the option to select the following three settings for each individual serial
port (port A, B, if available C, and D):

● Standard

● 5v on pins 1 and 9

● 12v on pins 1 and 9

NOTE: To access the Computer F10 Setup utility, restart the computer and press the F10 key as
soon as the HP logo screen is displayed (before the computer boots to the operating system).

CAUTION: Be careful when connecting peripheral devices to powered 5V and 12V serial ports. The
peripheral device must require the same voltage for which the powered serial port is configured.
Connecting a peripheral device that is not rated for the same voltage supplied by the powered serial
port can damage the computer and the peripheral device.
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Installing an Optional 12-Volt Powered USB Expansion Card

The computer is equipped with a 24-volt Powered USB connector on the riser card and one 12-volt
Powered USB connector on the system board. It may also have an optional 12-volt Powered USB
expansion card installed with three extra 12-volt Powered USB ports. The 24-volt Powered USB
connector and the 12-volt Powered USB connector are keyed differently as a precaution to prevent
connection errors.

No. Connector Color

1 24-volt Powered USB Red

2 12-volt Powered USB Teal

The 12-volt Powered USB expansion card must be installed in the PCI Express x1 expansion socket
on the riser card. If your riser card does not have a PCI Express x1 expansion socket, you can
replace the riser card with one that does have a PCI Express x1 expansion socket. Refer to Riser
Card on page 29 for more information.

To install a 12-volt Powered USB expansion card:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 15).

2. Remove the access panel (Access Panel on page 16).

3. Locate the PCI Express x1 expansion socket on the riser card. The Powered USB expansion
card must be installed in the PCI Express x1 expansion socket.
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4. Push outward on the tab located on the back of the expansion card retention latch inside the
chassis (1) and rotate the latch open (2).

Figure 4-1  Opening the Slot Cover Retention Latch

5. Before installing the expansion card, remove the expansion slot cover by sliding it out of the slot
on the rear of the chassis.

Figure 4-2  Removing an Expansion Slot Cover
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6. Install the Powered USB expansion card into the PCI Express x1 socket on the riser card. Move
the card toward the rear of the chassis so that the bracket on the card is aligned with the open
slot on the rear of the chassis (1). Press the card straight down into the expansion socket on the
riser card (2).

Figure 4-3  Installing the Powered USB Expansion Card in the Riser Card

7. The cable included with the card has a single connector on one end and dual connectors on the
other end. All three connectors are keyed to ensure proper connection. Connect the single end
of the cable to the rear of the card (1). Connect the green connector on the other end of the
cable to the green USB connector on the system board (2). Connect the black cable connector
to the black USB connector on the system board (3).

NOTE: The green USB connector on the system board has two rows of pins. You can attach
the green cable from the card to either row.

Figure 4-4  Connecting the 12-volt Powered USB Cable
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Riser Card
There are two riser cards available from HP for this product. One has a PCI slot and the other has a
PCI Express x1 slot. Both cards have a slot designated for the Powered Serial Port expansion card.

To replace the riser card:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 15).

2. Remove the access panel (Access Panel on page 16).

3. If an expansion card is installed in one of the riser card expansion slots, push outward on the tab
located on the back of the expansion card retention latch inside the chassis (1) and rotate the
latch open (2).

4. If an expansion card is installed in one of the riser card expansion slots, remove the card.
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5. To remove the riser card, pull back the arm on the back of the riser card socket (1), then lift the
riser card out of the riser card socket (2).

6. To install the new riser card, press the riser card firmly down into the riser card socket on the
system board. Make sure that the tab on the end of the riser card bracket seats into the slot on
the chassis when installing the card.
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7. If an expansion card was removed from the old riser card or you are installing a new expansion
card into the riser card, install the card into the appropriate slot on the new riser card. Move the
card toward the rear of the chassis so that the bracket on the card is aligned with the open slot
on the rear of the chassis (1). Press the card straight down into the expansion socket on the
riser card (2).

8. If an expansion card was removed from the old riser card and you are not replacing the
expansion card, install a slot cover in the expansion slot.

CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.
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Hard Drive
NOTE: The HP RP3 computer supports 2.5-inch Serial ATA (SATA) internal hard drives.

Before you remove the old hard drive, be sure to back up the data from the old hard drive so that you
can transfer the data to the new hard drive.

The 2.5-inch hard drive is enclosed in a carrier on the interior of the front panel. To replace the drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 15).

2. Remove the access panel (Access Panel on page 16).

3. Disconnect the cables from the rear of the hard drive.

4. Press outward on the release latch located on the front panel just above the cable connection on
the hard drive (1), then slide the carrier toward the center of the chassis and pull the carrier
straight back from the front panel to remove it (2).
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5. Press the retention arm on the rear of the carrier outward (1), then slide the drive forward and lift
it out of the carrier (2).

6. Remove the four mounting screws from the sides of the hard drive.

NOTE: Install the mounting screws on the sides of the new hard drive.

To install a hard drive, reverse the removal procedures.

NOTE: No configuration of the SATA hard drive is necessary; the computer automatically
recognizes it the next time you turn on the computer.
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Battery
The battery that comes with the computer provides power to the real-time clock. When replacing the
battery, use a battery equivalent to the battery originally installed in the computer. The computer
comes with a 3-volt lithium coin cell battery.

WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 60°C (140ºF).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

Replace the battery only with the HP spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/
recycle.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 15).

2. Remove the access panel (Access Panel on page 16).

3. Depending on the type of battery holder on the system board, complete the following instructions
to replace the battery.

Type 1

a. To release the battery from its holder, insert a thin metal instrument into the slot on the side
of the holder below the battery (1) and pry the battery up and out of the holder (2).

b. To insert the new battery, slide one edge of the replacement battery under the holder’s lip
with the positive side up (1) and press the other edge down into the holder so that it snaps
in place (2).

34 Chapter 4   Removal and Replacement Procedures

http://www.hp.com/recycle
http://www.hp.com/recycle


Type 2

a. To release the battery from its holder, squeeze the metal clamp that extends above one
edge of the battery. When the battery pops up, lift it out (1).

b. To insert the new battery, slide one edge of the replacement battery under the holder’s lip
with the positive side up. Push the other edge down until the clamp snaps over the other
edge of the battery (2).

NOTE: After the battery has been replaced, use the following steps to complete this procedure.

4. Replace the access panel.

5. Reconnect the power cord and any external devices, then turn on the computer.

6. Reset the date and time, your passwords, and any special system setups using Computer
Setup.

7. Lock any security devices that were disengaged when the computer access panel was removed.
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WLAN Module

Description Spare part number

Ralink RT5390R 802.11bgn 1x1 Wi-Fi Adapter (WLAN module) 701396-001

Atheros AR9462 802.11b/g/n Wi-Fi Adapter 701398-001

The WLAN module is located on the system board.

To remove the WLAN module:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 15).

2. Remove the access panel (Access Panel on page 16).

3. Disconnect the antenna cables from the module.
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4. Remove the Phillips screws that secure the module to the system board.

5. Lift the module to a 45-degree angle, and then pull it away to remove it from the socket.

To install the WLAN module, reverse the removal procedures.

NOTE: WLAN modules are designed with a notch to prevent incorrect insertion.

When connecting the antenna cables to the WLAN module, match the cable colors and labels on the
cables with the labels on the module.
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Front Fan/Baffle

Description Spare part number

Front fan assembly 682431-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 15).

2. Remove the access panel (Access Panel on page 16).

3. Remove the front bezel Front Bezel on page 17.

4. Disconnect the fan control cable from the system board connector labeled CHFAN.

5. Press the tabs that secure the fan assembly to the front of the chassis.

6. Rotate the assembly toward the rear of the unit, and then lift it out of the chassis.
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To install the fan assembly, reverse the removal procedures.

When installing the fan assembly, insert the posts on the bottom of the fan (1) into the slots built into
the base pan (2).
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Front USB and Power Switch Assembly

Description Spare part number

Front USB and power switch assembly 682432-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 15).

2. Remove the access panel (Access Panel on page 16).

3. Remove the front bezel (Front Bezel on page 17).

4. Remove the fan Front Fan/Baffle on page 38.

5. Disconnect the cables from the following system board connectors:

● FRONT USB (yellow)

● PB/LED (black)

● FRONT AUD (blue)

6. Press in on the two tabs on each side of the assembly (1).

7. Rotate the top of the assembly downward, and then pull the assembly out through the hole in the
front of the chassis (2) while guiding the wires through the hole in the chassis.

To reinstall the front USB and power switch, reverse the removal procedure.
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Speaker

Description Spare part number

Speaker 647447-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 15).

2. Remove the access panel (Access Panel on page 16).

3. Remove the front bezel (Front Bezel on page 17).

4. Remove the fan (Front Fan/Baffle on page 38).

5. Remove the two Torx T8 screws that secure the speaker to the chassis (1).
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6. Disconnect the speaker wire from the system board connector labeled SPKR (2), and then
remove the speaker from the chassis (3).

To install the speaker, reverse the removal procedures.

Power Supply

Description Spare part number

Power supply, 115W 682435-001

WARNING! Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord
should be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 15).

2. Remove the access panel Access Panel on page 16).

3. Rotate the optical drive cage to its upright position.

4. Disconnect the power cables from all of the drives.

5. Rotate the power supply to its upright position.

6. Disconnect the power cables from the following white system board connectors:

● PWRCMD

● PWR
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7. From the rear of the computer, remove the four Torx screws (1) that secure the power supply to
the chassis (1).

8. From the inside of the computer, press the level on the base pan in front of the power supply (2),
and then rotate the power supply so you can remove it from the chassis (3).

To install the power supply, reverse the removal procedure.

CAUTION: When installing the power supply cables, make sure they are properly positioned so
they are not cut by the drive cage and are not pinched by the rotating power supply.
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System Board

Description Spare part number

System board (includes Intel Celeron 807UE processor; includes thermal material) 682426-001

The system board includes a non-removable Intel Celeron 807UE processor soldered to the board.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 15).

2. Remove the access panel (Access Panel on page 16).

3. Remove the riser card cage Riser Card on page 29.

4. Remove the fan assembly (Front Fan/Baffle on page 38).

5. When replacing the system board, make sure the following components are removed from the
defective system board and installed on the replacement system board:

● Memory modules (Memory on page 20)

● Expansion cards (Expansion Cards on page 22)

6. Disconnect all data, power, and any other cables from the system board.

7. Remove the seven screws that secure the system board to the floor of the chassis.

8. Slide the system board tray assembly toward the front of the chassis to disengage the rear ports,
and then lift the system board up and out of the chassis.

To install the system board, reverse the removal procedure.
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A Computer Setup (F10) Utility

Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash
media devices.

● Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run
during a Full Boot. You can set the system to:

❑ always Quick Boot (default);

❑ periodically Full Boot (from every 1 to 30 days); or

❑ always Full Boot.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as
memory count, product name, and other non-error text messages. If a POST error occurs, the
error is displayed regardless of the mode selected. To manually switch to Post Messages
Enabled during POST, press any key (except F1 through F12).

● Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

● Enter the Asset Tag or property identification number assigned by the company to this computer.

● Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

● Establish a setup password that controls access to the Computer Setup (F10) Utility and the
settings described in this section.

● Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or
embedded NIC, so that they cannot be used until they are unsecured.

● Enable or disable removable media boot ability.
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● Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

● Replicate the system setup by saving system configuration information on a USB device and
restoring it on one or more computers.

● Execute self-tests on a specified ATA hard drive (when supported by drive).

● Enable or disable DriveLock security (when supported by drive).

Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system.
To access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.

2. Repeatedly press F10 when the monitor light turns green to access the utility.

You can also press Esc to a menu that allows you to access different options available at
startup, including the Computer Setup utility.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and
again repeatedly press F10 when the monitor light turns green to access the utility.

3. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and
down) keys to select the option you want, then press Enter. To return to the Computer Setup
Utilities menu, press Esc.

5. To apply and save changes, select File > Save Changes and Exit.

● If you have made changes that you do not want applied, select Ignore Changes and Exit.

● To reset to factory settings or previously saved default settings (some models), select
Apply Defaults and Exit. This option will restore the original factory system defaults.

NOTE: Not all settings shown in the following sections are available for all models

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only
after exiting the F10 Setup screen.

Table A-1  Computer Setup (F10) Utility

Heading Table

File Computer Setup—File on page 47

Storage Computer Setup—Storage on page 48

Security Computer Setup—Security on page 51

Power Computer Setup—Power on page 54

Advanced Computer Setup—Advanced on page 55
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Computer Setup—File

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table A-2  Computer Setup—File

Option Description

System Information Lists:

● Product name

● SKU number

● Processor type/speed/stepping

● Cache size (L1/L2/L3) (dual core processors have this listed twice)

● Installed memory size/speed, number of channels (single or dual) (if applicable)

● Integrated MAC address for embedded, enabled NIC (if applicable)

● System BIOS (includes family name and version)

● Chassis serial number

● Asset tracking number

● ME firmware version

● ME Management mode

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Flash System ROM Allows you to update the system ROM with a BIOS image file located on removable media.

Replicated Setup Save to Removable Media

Saves system configuration to a formatted USB flash media device.

Restore from Removable Media

Restores system configuration from a USB flash media device.

Default Setup Save Current Settings as Default

Saves the current system configuration settings as the default.

Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and
Exit

Applies the currently selected default settings and clears any established passwords.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and
Exit

Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table A-3  Computer Setup—Storage

Option Description

Device Configuration Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

● Hard Disk: Size, model, firmware version, serial number, connector color.

Translation mode (ATA disks only)

Lets you select the translation mode to be used for the device. This enables the BIOS to
access disks partitioned and formatted on other systems and may be necessary for users of
older versions of UNIX (e.g., SCO UNIX version 3.2). Options are Automatic, Bit-Shift,
LBA Assisted, User, and Off.

Available only when the drive translation mode is set to User, allows you to specify the
parameters (logical cylinders, heads, and sectors per track) used by the BIOS to translate
disk I/O requests (from the operating system or an application) into terms the hard drive can
accept. Logical cylinders may not exceed 1024. The number of heads may not exceed 256.
The number of sectors per track may not exceed 63.

CAUTION: Ordinarily, the translation mode selected automatically by the BIOS should not
be changed. If the selected translation mode is not compatible with the translation mode that
was active when the disk was partitioned and formatted, the data on the disk will be
inaccessible.

● CD-ROM: Model, firmware version, serial number, connector color (not included for USB CD-
ROM).

● SSD Life Used

NOTE: Displays for solid-state drives.

● SMART (ATA disks only)

● Diskette: Model and firmware version.

NOTE: Displays for USB diskette drives.

● Default Values (ATA disks only)

See Translation Mode above for details.

SATA Defaults
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Table A-3  Computer Setup—Storage (continued)

Storage Options eSATA Port

Allows you to set a SATA port as an eSATA port for use with an external drive. Default is enabled.

This setting affects only the port with the black connector, labeled as eSATA on the system board.
This port should have the eSATA back panel connector attached to use eSATA drives. For more
information, see the eSATA white paper at www.hp.com.

SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating
system. There are three supported options: IDE, RAID, and AHCI (default).

CAUTION: SATA emulation changes may prevent access to existing hard drive data and
degrade or corrupt established volumes.

IDE - This is the most backwards-compatible setting of the three options. Operating systems
usually do not require additional driver support in IDE mode.

RAID - Allows DOS and boot access to RAID volumes. Use this mode with the RAID device driver
loaded in the operating system to take advantage of RAID features.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.

NOTE: The RAID/AHCI device driver must be installed prior to attempting to boot from a RAID/
AHCI volume. If you attempt to boot from a RAID/AHCI volume without the required device driver
installed, the system will crash (blue screen). RAID volumes may become corrupted if they are
booted to after disabling RAID.

Removable Media Boot

Enables/disables ability to boot the system from removable media. Default is enabled.

Max eSATA Speed

Allows you to choose 1.5 Gbps or 3.0 Gpbs as the maximum eSATA speed. By default, the speed
is limited to 1.5 Gbps for maximum reliability.

CAUTION: Consult your eSATA drive and cable manufacturer before enabling 3.0 Gpbs speed.
Some drive and cable combinations may not run reliably at 3.0 Gpbs.
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Table A-3  Computer Setup—Storage (continued)

DPS Self-Test Allows you to execute self-tests on ATA hard drives capable of performing the Drive Protection
System (DPS) self-tests.

NOTE: This selection will only appear when at least one drive capable of performing the DPS
self-tests is attached to the system.

Boot Order Allows you to:

● EFI Boot Sources: Specify the order in which EFI boot sources (such as a internal hard
drive, USB hard drive, USB optical drive, or internal optical drive) are checked for a bootable
operating system image. Each device on the list may be individually excluded from or
included for consideration as a bootable operating system source.

EFI boot sources always have precedence over legacy boot sources.

● Legacy Boot Sources: Specify the order in which legacy boot sources (such as a network
interface card, internal hard drive, USB optical drive, or internal optical drive) are checked for
a bootable operating system image. Each device on the list may be individually excluded
from or included for consideration as a bootable operating system source.

Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: To drag a device to a preferred place, press Enter. To remove the device from
consideration as a bootable device, press F5.

You can use F5 to disable individual boot items, as well as disable EFI boot and/or legacy boot.

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating
system has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping
the boot menu) when the monitor light turns green. After POST is completed, a list of bootable
devices is displayed. Use the arrow keys to select the preferred bootable device and press Enter.
The computer then boots from the selected non-default device for this one time.
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Computer Setup—Security

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table A-4  Computer Setup—Security

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

Power-On Password Allows you to set and enable a power-on password. The power-on password prompt appears
after a power cycle or reboot. If the user does not enter the correct power-on password, the unit
will not boot.

Password Options

(This selection appears
only if a power-on
password or setup
password is set.)

Allows you to enable/disable:

● Lock Legacy Resources (determines whether or not Windows Device Manager is allowed to
change resource settings for serial and parallel ports).

● Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing,
the F10 Setup Options without entering setup password). Default is enabled.

● Password prompt on F9 & F12 (requires setup password to use these boot functions).
Default is enabled.

● Network Server Mode. Default is disabled.

Smart Cover Allows you to:

● Lock/unlock the Cover Lock.

● Set the Cover Removal Sensor to Disable/Notify User/Setup Password.

NOTE: Notify User alerts the user that the sensor has detected that the cover has been
removed. Setup Password requires that the setup password be entered to boot the computer if
the sensor detects that the cover has been removed.

Device Security Allows you to set Device Available/Device Hidden (default is Device Available) for:

● Embedded security device

● System audio

● USB controller (varies by model)

● Network controller

NOTE: You must disable AMT before trying to hide the network controller.

● Serial port

● Parallel port

● SATA ports (varies by model)

USB Security Allows you to set Enabled/Disabled (default is Enabled) for:

● Front USB Ports

● Rear USB Ports

● Accessory USB Ports

Computer Setup (F10) Utilities 51



Table A-4  Computer Setup—Security (continued)

Slot Security Allows you to disable any PCI or PCI Express slot. Default is enabled.

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI
expansion card or embedded on the system board.) Default is enabled.

System IDs Allows you to set:

● Asset tag (18-byte identifier), a property identification number assigned by the company to
the computer.

● Ownership tag (80-byte identifier) displayed during POST.

● Universal Unique Identifier (UUID) number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are normally set in the factory and are
used to uniquely identify the system.)

● Keyboard locale setting for System ID entry.

Master Boot Record
Security

Enables/disables Master Boot Record (MBR) security.

The MBR contains information needed to successfully boot from a disk and to access the data
stored on the disk. Master Boot Record Security may prevent unintentional or malicious changes
to the MBR, such as those caused by some viruses or by the incorrect use of certain disk utilities.
It also allows you to recover the "last known good" MBR, should changes to the MBR be detected
when the system is restarted.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the
current bootable disk while in MS-DOS or Windows Safe Mode.

NOTE: Most operating systems control access to the MBR of the current bootable disk; the
BIOS cannot prevent changes that may occur while the operating system is running.

Restores the backup Master Boot Record to the current bootable disk. Default is disabled.

Only appears if all of the following conditions are true:

● MBR security is enabled

● A backup copy of the MBR has been previously saved

● The current bootable disk is the same disk from which the backup copy was saved

CAUTION: Restoring a previously saved MBR after a disk utility or operating system has
modified the MBR, may cause the data on the disk to become inaccessible. Only restore a
previously saved MBR if you are confident that the current bootable disk's MBR has been
corrupted or infected with a virus.
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Table A-4  Computer Setup—Security (continued)

System Security
(these options are
hardware dependent)

Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches.
Default is enabled.

SVM CPU Virtualization (enable/disable). Controls the virtualization features of the processor.
Changing this setting requires turning the computer off and then back on. Default is disabled.

Virtualization Technology (VTx) (enable/disable) - Controls the virtualization features of the
processor. Changing this setting requires turning the computer off and then back on. Default is
disabled.

Virtualization Technology Directed I/O (VTd) (enable/disable) - Controls virtualization DMA
remapping features of the chipset. Changing this setting requires turning the computer off and
then back on. Default is disabled.

Trusted Execution Technology (enable/disable) - Controls the underlying processor and chipset
features needed to support a virtual appliance. Changing this setting requires turning the
computer off and then back on. Default is disabled. To enable this feature you must enable the
following features:

● Embedded Security Device Support

● Virtualization Technology

● Virtualization Technology Directed I/O

Embedded Security Device (enable/disable) - Permits activation and deactivation of the
Embedded Security Device.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

● Reset to Factory Settings (Do not reset/Reset) - Resetting to factory defaults will erase all
security keys and leave the device in a disabled state. Changing this setting requires that
you restart the computer. Default is Do not reset.

CAUTION: The embedded security device is a critical component of many security
schemes. Erasing the security keys will prevent access to data protected by the Embedded
Security Device. Choosing Reset to Factory Settings may result in significant data loss.

● Measure boot variables/devices to PCR1 - Typically, the computer measures the boot path
and saves collected metrics to PCR5 (a register in the Embedded Security Device). Bitlocker
tracks changes to any of these metrics, and forces the user to re-authenticate if it detects
any changes. Enabling this feature lets you set Bitlocker to ignore detected changes to boot
path metrics, thereby avoiding re-authentication issues associated with USB keys inserted in
a port. Default is enabled.

System Security
(continued)

OS management of Embedded Security Device (enable/disable) - This option allows the user to
limit OS control of the Embedded Security Device. Default is enabled. This option is automatically
disabled if Trusted Execution Technology is enabled.

● Reset of Embedded Security Device through OS (enable/disable) - This option allows the
user to limit the operating system ability to request a Reset to Factory Settings of the
Embedded Security Device. Default is disabled.

NOTE: To enable this option, a Setup password must be set.

DriveLock Security Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the DriveLock passwords during POST. If neither
is successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock
feature is attached to the system.
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Computer Setup—Power

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table A-5  Computer Setup—Power

Option Description

OS Power
Management

● Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
processors power consumption when the processor is idle. Default is extended.

● Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
processor voltage and frequency when the current software load does not require the full
capabilities of the processor. Default is enabled.

● Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a
visual indication of what sleep state the system is in. Each sleep state has a unique blink
pattern. Default is disabled.

◦ S0 (On) = Solid green LED.

◦ S3 (Stand By)= 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(green LED) — repeated cycles of 3 blinks and a pause.

◦ S4 (Hibernation)= 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(green LED) — repeated cycles of 4 blinks and a pause.

◦ S5 (Soft Off) = LED is off.

Hardware Power
Management

SATA Power Management – Enables or disables SATA bus and/or device power management.
Default is enabled.

S5 Maximum Power Savings – Turns off power to all nonessential hardware when system is off to
meet EUP Lot 6 requirement of less than 0.5 Watt power usage. Default is disabled.

PCI Express x16 Slot 1 – Sets Active State Power Management (ASPM) of the bus. ASPM lets
you set lower power modes that activate when the bus is not being used. Options are Disabled,
LOs, L1, LOs and L1. Default is ASPM Disabled.

PCI Express x1 Slot 1 – Sets Active State Power Management (ASPM) of the bus. ASPM lets you
set lower power modes that activate when the bus is not being used. Options are Disabled, LOs,
L1, LOs and L1. Default is ASPM Disabled.

Network Controller – Sets ASPM of the bus. ASPM lets you set lower power modes that activate
when the bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM
Disabled.

USB 3.0 Controller – Sets ASPM of the bus. ASPM lets you set lower power modes that activate
when the bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM
Disabled.

Thermal Fan idle mode—This bar graph controls the minimum permitted fan speed.

NOTE: This setting only changes the minimum fan speed. The fans are still automatically
controlled.
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Computer Setup—Advanced

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table A-6  Computer Setup—Advanced (for advanced users)

Option Heading

Power-On Options Allows you to set:

● POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).

◦ QuickBoot (default) = Do not clear memory or perform a memory test.

◦ FullBoot = Memory test (count) on cold boot. Clears memory on all boots.

◦ Clear Memory = No memory count on cold boot. Clears memory on all boots.

◦ FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No
more memory counts until 1st cold boot on or after x days. Clears memory on all boots.

● POST messages (enable/disable). Enabling this feature will cause the system to display
POST error messages, which are error messages displayed on the monitor during the Power
On Self Test if the BIOS encounters some kind of problem while starting the PC. A POST
error message will only display on screen if the computer is capable of booting this far. If the
POST detects an error before this point, a beep code is generated instead. Default is
disabled.

● Press the ESC key for Startup Menu (Enable/Disable). This feature controls the display of
the text “Press the ESC key for Startup Menu” during POST. Default is enabled.

● Option ROM Prompt (enable/disable). Enabling this feature will cause the system to display
a message before loading option ROMs. Default is enabled.

● After Power Loss (off/on/previous state). Default is Power off. Setting this option to:

◦ Power off—causes the computer to remain powered off when power is restored.

◦ Power on—causes the computer to power on automatically as soon as power is
restored.

◦ Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able to use the suspend/sleep feature or the Remote Management features.

● POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST
process. This delay is sometimes needed for hard disks on some PCI cards that spin up very
slowly, so slowly that they are not ready to boot by the time POST is finished. The POST
delay also gives you more time to select F10 to enter Computer (F10) Setup. Default is
None.

● Remote Wakeup Boot Source (remote server/local hard drive). Default is Local hard drive.

● Factory Recovery Boot Support (Enable/Disable). Provides the ability for the BIOS to redirect
the boot to the recovery partition on the user hard drive, if present. Some versions of the
recovery software honor the F11 key press even when this feature is disabled by the BIOS.
Default is disabled.

● Bypass F1 Prompt on Configuration Changes (Enable/Disable). Allows you to set the
computer not to confirm when changes were made. Default is disabled.

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.
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Table A-6  Computer Setup—Advanced (for advanced users) (continued)

Onboard Devices Allows you to set resources for or disable Legacy devices.

Allows to you change voltage settings for serial ports A, B, C, and D. Available voltage settings
are:

● 0v (default)

● +5v

● +12v

Bus Options Allows you to enable or disable:

● PCI SERR# Generation. Default is enabled.

● PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed. Default is disabled.

Device Options Allows you to set:

● Printer mode (Bi-Directional, EPP + ECP, Output Only). ECP = Enhanced Capabilities Port,
EPP = Enhanced Parallel Port. Default is EPP+ECP.

● Num Lock State at Power-On (off/on). Default is off.

● Integrated Video (enable/disable). Use this option to disable the integrated video controller
when another video controller is present in the system. Default is enabled.

● Integrated Graphics (Auto/Disable/Force) Use this option to manage integrated (UMA)
graphics memory allocation. The value you choose is allocated permanently to graphics and
is unavailable to the operating system. For example, if you set this value to 512M on a
system with 2 GB of RAM, the system always allocates 512 MB for graphics and the other
1.5 GB for use by the BIOS and operating system. Default is Auto which sets memory
allocation to 512 MB.

If you select Force, the UMA Frame Buffer Size option displays, which lets you set the UMA
memory size allocation between 32 MB and 1 GB.

● Internal Speaker (does not affect external speakers). Default is enabled.

● NIC PXE Option ROM Download (PXE, iSCSI, disabled). The BIOS contains an embedded
NIC option ROM to allow the unit to boot through the network to a PXE server. This is
typically used to download a corporate image to a hard drive. The NIC option ROM takes up
memory space below 1MB commonly referred to as DOS Compatibility Hole (DCH) space.
This space is limited. This F10 option will allow users to disable the downloading of this
embedded NIC option ROM thus giving more DCH space for additional PCI cards which may
need option ROM space. The default will be to have the NIC option-ROM-enabled. Default is
PXE.

● SATA RAID Option ROM Download (enable/disable). The BIOS contains an embedded
SATA RAID option ROM for RAID support. This can be temporarily disabled to save DCH
space. Note that with the option ROM disabled, users will be unable to boot to hard drives in
the system while running in RAID mode. Default is disabled.

● Multi-Processor (enable/disable). Use this option to disable multi-processor support under
the OS. Default is enabled.

● Hyper threading (enable/disable). Use this option to disable processor hyper-threading.

● Turbo Mode (enable/disable). Allows you to enable and disable the Intel Turbo Mode feature,
which allows one core of the system to run at a higher than standard frequency and power if
other cores are idle. Default is enabled.
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Table A-6  Computer Setup—Advanced (for advanced users) (continued)

VGA Configuration Displayed only if there is an add-in video card in the system. Allows you to specify which VGA
controller will be the “boot” or primary VGA controller.

AMT Configuration Allows you to set:

● AMT (enable/disable). Allows you to enable or disable functions of the embedded
Management Engine (ME) such as Active Management Technology (AMT). If set to disable,
the Management Engine is set to a temporarily disabled state and will not provide functions
beyond necessary system configuration. Default is enabled.

● Unconfigure AMT/ME (enable/disable). Allows you to unconfigure any provisioned
management settings for AMT. The AMT settings are restored to factory defaults. This
feature should be used with caution as AMT will not be able to provide any set AMT
management functions once unconfigured. Default is disabled.

● Hide Unconfigure ME Confirmation Prompt (enable/disable). Allows you to set the system to
not display the confirmation to unconfigure ME.

● Watchdog Timer (enable/disable). Allows you to set amount of time for a operating system
and BIOS watchdog alert to be sent if the timers are not deactivated. BIOS watchdog is
deactivated by BIOS and would indicate that a halt occurred during execution if the alert is
sent to the management console. An operating system alert is deactivated by the operating
system image and would indicate that a hang occurred during its initialization. Default is
enabled.

Recovering the Configuration Settings
This method of recovery requires that you first perform the Save to Removable Media command
with the Computer Setup (F10) Utility before Restore is needed. (See Computer Setup—File
on page 47 in the Computer Setup—File table.)

NOTE: It is recommended that you save any modified computer configuration settings to a USB
flash media device and save the device for possible future use.

To restore the configuration, insert the USB flash media device with the saved configuration and
perform the Restore from Removable Media command with the Computer Setup (F10) Utility. (See
Computer Setup—File on page 47 in the Computer Setup—File table.)
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B Using HP PC Hardware Diagnostics

To help in troubleshooting and diagnosing failures, use the UEFI-based hardware diagnostic solution
that HP includes on all products. You can use this tool even if the computer will not boot to the
operating system.

Why run HP PC Hardware Diagnostics - UEFI
The HP PC Hardware Diagnostic tools simplify the process of diagnosing hardware issues and
expedite the support process when issues are found. The tools save time by pinpointing the
component that needs to be replaced.

● Isolate true hardware failures: The diagnostics run outside of the operating system so they
effectively isolate hardware failures from issues that may be caused by the operating system or
other software components.

● Failure ID: When a failure is detected that requires hardware replacement, a 24-digit Failure ID
is generated. This ID can then be provided to the call agent, who will either schedule support or
provide replacement parts.

How to access and run HP PC Hardware Diagnostics
You can run the diagnostics from one of three places, depending on your preference and the health
of the computer.

1. A connected USB drive (to download the diagnostics tools to a USB drive, see the instructions in
Downloading HP PC Hardware Diagnostics to a USB device on page 59).

2. The hard disk drive.

NOTE: This option is not available on models with 32 GB solid-state drives.

3. A core set of diagnostics in the BIOS (for memory and hard disk drive) that are accessible only if
the USB or hard disk drive versions are not detected.

1. Turn on the computer and press Esc repeatedly until the BIOS Boot Menu appears.

2. Press F2 or select Diagnostics (F2).

Pressing F2 signals the system to search for the diagnostics from the three locations in the order
listed above.
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Downloading HP PC Hardware Diagnostics to a USB
device

1. Go to http://www.hp.com.

2. Click the Support & Drivers link.

3. Select the Drivers & Software tab.

4. Enter the product name in the text box and click Search.

5. Select your specific computer model.

6. Select your operating system.

7. In the Diagnostic section, click the HP UEFI Support Environment link. This link provides
additional information.

- or -

Click the Download button and select Run. The download includes instructions (in English) on
how to install the tools on the USB device.

NOTE: HP diagnostic solutions are developed to test components typically included on HP
products. They may not diagnose all third-party accessories that can be added to the system.

Downloading HP PC Hardware Diagnostics to a USB device 59
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C Restoring and recovering

To protect from loss or damage, back up your personal data files. Refer to the operating system or
backup utility documentation for instructions on making backup copies of your data files.

To protect the software from loss or damage, keep a backup copy of all system software,
applications, and related files stored on the hard drive.

If you cannot create system recovery CDs or DVDs, you can order a recovery disk set from support.
To obtain the support telephone number for your region, see http://www.hp.com/support/contactHP.

System Restore
If you have a problem that might be due to software that you installed on your computer, use System
Restore to return the computer to a previous restore point. You can also set restore points manually.

NOTE: Always use this System Restore procedure before you use the System Recovery feature.

NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

To start System Restore:

1. Close all open programs.

2. Click the Start button, right-click Computer, and then click Properties.

3. Click System protection, System Restore, click Next, and then follow the on-screen
instructions.

To add restore points manually:

1. Close all open programs.

2. Click the Start button, right-click Computer, click Properties, and then click System
protection.

3. Under Protection Settings, select the disk for which you want to create a restore point.

4. Click Create, and then follow the on-screen instructions.

System Recovery
WARNING! This procedure will delete all user information. To prevent loss of information, be sure
to back up all user information so you can restore it after recovery.
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System Recovery completely erases and reformats the hard disk drive, deleting all data files that you
have created, and then reinstalls the operating system, programs, and drivers. However, you must
reinstall any software that was not installed on the computer at the factory. This includes software that
came on media included in the computer accessory box, and any software programs you installed
after purchase.

NOTE: Always use the System Restore procedure before you use the System Recovery program.
See System Restore on page 60.

NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

You must choose one of the following methods to perform a System Recovery:

● Recovery image — Run System Recovery from a recovery image stored on your hard disk drive.
The recovery image is a file that contains a copy of the original factory-shipped software. To
perform a System Recovery from a recovery image, see System Recovery when Windows is
responding on page 61 or System Recovery when Windows is not responding on page 62.

● Recovery media — Run System Recovery from recovery media that you have created from files
stored on your hard disk drive or purchased separately. To create recovery media, see System
recovery using recovery media on page 62.

System Recovery when Windows is responding

CAUTION: System Recovery deletes all data and programs you created or installed. Before you
begin, back up any important data to a CD or DVD or to a USB flash drive.

NOTE: In some cases, you must use recovery media for this procedure. To create this media, follow
the instructions in Creating recovery media on page 63.

If the computer is working and Windows 7 is responding, use these steps to perform a System
Recovery.

1. Turn off the computer.

2. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

3. Turn on the computer.

4. When Windows has loaded, click the Start button, click All Programs, click Security and
Protection, click Recovery Manager, and then click Recovery Manager. If prompted, click Yes
to allow the program to continue.

5. Under I need help immediately, click System Recovery.

6. Select Yes, and then click Next. Your computer restarts.

NOTE: If your system does not detect a recovery partition, it prompts you to insert recovery
media that you have created. Insert the first disc or the USB flash drive, select Yes, and then
click Next to restart the computer. If you are using discs, insert the next disc when prompted.

7. When the computer restarts, you will see the Recovery Manager welcome screen again. Under I
need help immediately, click System Recovery. If you are prompted to back up your files, and
you have not done so, select Back up your files first (recommended), and then click Next.
Otherwise, select Recover without backing up your files, and then click Next.
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8. System Recovery begins. After System Recovery is complete, click Finish to restart the
computer.

9. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System Recovery when Windows is not responding

CAUTION: System Recovery deletes all data and programs you created or installed.

If Windows is not responding, but the computer is working, follow these steps to perform a System
Recovery.

1. Turn off the computer. If necessary, press and hold the power button until the computer turns off.

2. Disconnect all peripheral devices from the computer, except the monitor, keyboard, and mouse.

3. Press the power button to turn on the computer.

4. As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the
Windows is Loading Files… message appears on the screen.

5. Under I need help immediately, click System Recovery.

6. If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing up
your files, and then click Next.

7. System Recovery begins. After System Recovery is complete, click Finish to restart the
computer.

8. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System recovery using recovery media

You should create a set of recovery media, either a set of DVDs or a USB flash drive, from the
recovery image stored on your hard disk drive. This image contains the operating system and
software program files that were originally installed on your computer at the factory. You can create
only one set of recovery media for your computer, and the media can be used only with this
computer. Store the recovery media in a safe place.

NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

● To create recovery discs, your computer must have a DVD writer, and you must use only high-
quality blank DVD+R or DVD-R discs.

NOTE: You cannot use DVD+RW, DVD-RW, DVD+RW DL, DVD-RW DL, DVD+R DL, or DVD-
R DL discs to create recovery discs.

● You have the option of creating a recovery USB flash drive instead, using a high-quality USB
drive.
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● If you are creating recovery discs, be sure to use high-quality discs. It is normal for the system to
reject defective discs. You will be prompted to insert a new blank disc to try again.

● The number of discs in the recovery-disc set depends on your computer model (typically 3 to 6
DVDs). The Recovery Media Creation program tells you the specific number of blank discs
needed to make the set. If you are using a USB flash drive, the program will tell you the size of
the drive required to store all the data (minimum of 8 GB).

NOTE: The process of creating recovery media is lengthy. You can quit the process at any
time. The next time you initiate the process, it resumes where it left off.

Creating recovery media

To create recovery discs:

1. Close all open programs.

2. Click the Start button, click All Programs, click Security and Protection, and then click HP
Recovery Media Creation. If prompted, click Yes to allow the program to continue.

3. Click Create recovery media using blank DVD(s), and then click Next.

4. Follow the on-screen instructions. Label each disc as you make it (for example, Recovery 1,
Recovery 2), and then store the discs in a secure place.

To create a recovery USB flash drive:

NOTE: You must use a flash drive with a capacity of at least 8 GB.

1. Close all open programs.

2. Insert the USB flash drive into a USB port on the computer.

3. Click the Start button, click All Programs, click Security and Protection, and then click
Recovery Media Creation.

4. Click Create recovery media with a USB flash drive, and then click Next.

5. Select the USB flash drive from the list of media. The program will let you know how much
storage is required to create the recovery drive. If the USB flash drive does not have enough
storage capacity, it will appear grayed out, and you must replace it with a larger USB flash drive.
Click Next.

NOTE: Recovery Media Creation formats the flash drive, deleting any files on it.

6. Follow the on-screen instructions. When the process is complete, label the USB flash drive and
store it in a secure place.

NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up
from a media card and you may not be able to run system recovery.
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Using recovery media

CAUTION: System Recovery deletes all data and programs you have created or installed. Back up
any important data to a CD or DVD or to a USB flash drive.

To create recovery media, see System recovery using recovery media on page 62.

To perform a System Recovery using recovery media:

1. If using a set of DVDs, insert the first recovery disc into the DVD drive tray, and close the tray. If
you are using a recovery USB flash drive, insert it into a USB port.

2. If the computer is not responding, press and hold the power button for approximately 5 seconds
or until the computer turns off.

or

Click the Start button, and then click Shut Down.

3. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

4. Press the power button to turn on the computer.

5. Press Esc as the computer is powering on to see the startup menu. Use the arrow keys to select
the boot menu and press Enter. Use the arrow keys to select the location where the recovery
media is inserted (USB or DVD). Press Enter to boot from that device.

6. If Recovery Manager asks if you want to run System Recovery from Media or Hard Drive, select
Media. On the Welcome screen, under I need help immediately, click Factory Reset.

7. If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing up
your files, and then click Next.

8. If you are prompted to insert the next recovery disc, do so.

9. When Recovery Manager is finished, remove the recovery disc or the recovery USB flash drive
from the system.

10. Click Finish to restart the computer.
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D POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the
probable source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count
and non-error text messages. If a POST error occurs, the screen will display the error message. To
manually switch to the POST Messages Enabled mode during POST, press any key (except F10 or
F12). The default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level tests, such as the
memory test. Full Boot runs all of the ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

NOTE: For more information on Computer Setup, see the Computer Setup (F10) Utility Guide on
the Documentation and Diagnostics CD.

Power-On Self-Test (POST)
POST is a series of diagnostic tests that runs automatically when the system is turned on. POST
checks the following items to ensure that the computer system is functioning properly:

● Keyboard

● Memory modules

● All mass storage devices

● Processors

● Controllers

NOTE: If the Power-On Password is set, a key icon appears on the screen while POST is running.
You will need to enter the password before continuing.

If POST finds an error in the system, an audible and/or visual message occurs.
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POST Numeric Codes and Text Messages
This section covers those POST errors that have numeric codes associated with them. The section
also includes some text messages that may be encountered during POST.

NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table D-1  Numeric Codes and Text Messages

Control panel message Description Recommended action

101-Option ROM Checksum Error System ROM or expansion board option
ROM checksum.

1. Verify the correct ROM.

2. Flash the ROM if needed.

3. If an expansion board was recently
added, remove it to see if the problem
remains.

4. Clear CMOS.

5. If the message disappears, there may
be a problem with the expansion card.

6. Replace the system board.

103-System Board Failure DMA or timers. 1. Clear CMOS.

2. Remove expansion boards.

3. Replace the system board.

110-Out of Memory Space for Option ROMs Recently added PCI expansion card
contains an option ROM too large to
download during POST.

1. If a PCI expansion card was recently
added, remove it to see if the problem
remains.

2. In Computer Setup, set Advanced >
Device Options > NIC PXE Option
ROM Download to DISABLE to
prevent PXE option ROM for the
internal NIC from being downloaded
during POST to free more memory for
an expansion card's option ROM.
Internal PXE option ROM is used for
booting from the NIC to a PXE server.

3. Ensure the ACPI/USB Buffers @ Top
of Memory setting in Computer Setup
is enabled.

162-System Options Not Set Configuration incorrect.

RTC (real-time clock) battery may need to
be replaced.

Run Computer Setup and check the
configuration in Advanced > Onboard
Devices.

Reset the date and time under Control
Panel. If the problem persists, replace the
RTC battery. See the Hardware Reference
Guide on the Documentation and
Diagnostics CD for instructions on installing
a new battery, or contact an authorized
dealer or reseller for RTC battery
replacement.
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Table D-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

163-Time & Date Not Set Invalid time or date in configuration
memory.

RTC (real-time clock) battery may need to
be replaced.

Reset the date and time under Control
Panel (Computer Setup can also be used).
If the problem persists, replace the RTC
battery. See the Hardware Reference Guide
on the Documentation and Diagnostics CD
for instructions on installing a new battery,
or contact an authorized dealer or reseller
for RTC battery replacement.

163-Time & Date Not Set CMOS jumper may not be properly
installed.

Check for proper placement of the CMOS
jumper if applicable.

164-MemorySize Error Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.

164-MemorySize Error Memory configuration incorrect. 1. Run Computer Setup or Windows
utilities.

2. Make sure the memory module(s) are
installed properly.

3. If third-party memory has been added,
test using HP-only memory.

4. Verify proper memory module type.

201-Memory Error RAM failure. 1. Run Computer Setup or Windows
utilities.

2. Ensure memory modules are correctly
installed.

3. Verify proper memory module type.

4. Remove and replace the identified
faulty memory module(s).

5. If the error persists after replacing
memory modules, replace the system
board.

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

A memory module in memory socket
identified in the error message is missing
critical SPD information, or is incompatible
with the chipset.

1. Verify proper memory module type.

2. Try another memory socket.

3. Replace DIMM with a module
conforming to the SPD standard.

214-DIMM Configuration Warning Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Recently added memory module(s) support
ECC memory error correction.

1. If additional memory was recently
added, remove it to see if the problem
remains.

2. Check product documentation for
memory support information.
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Table D-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

301-Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

303-Keyboard Controller Error I/O board keyboard controller. 1. Reconnect keyboard with computer
turned off.

2. Replace the system board.

304-Keyboard or System Unit Error Keyboard failure. 1. Reconnect the keyboard with computer
turned off.

2. Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.

404-Parallel Port Address Conflict Detected Both external and internal ports are
assigned to parallel port X.

1. Remove any parallel port expansion
cards.

2. Clear CMOS.

3. Reconfigure card resources and/or run
Computer Setup.

410-Audio Interrupt Conflict IRQ address conflicts with another device. Enter Computer Setup and reset the IRQ in
Advanced > Onboard Devices.

411-Network Interface Card Interrupt
Conflict

IRQ address conflicts with another device. Enter Computer Setup and reset the IRQ in
Advanced > Onboard Devices.

501-Display Adapter Failure Graphics display controller. 1. Reseat the graphics card
(if applicable).

2. Clear CMOS.

3. Verify monitor is attached and turned
on.

4. Replace the graphics card (if possible).

510-Flash Screen Image Corrupted Flash Screen image has errors. Reflash the system ROM with the latest
BIOS image.

511-CPU, CPUA, or CPUB Fan not
Detected

CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.

2. Reseat fan cable.

3. Replace CPU fan.
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Table D-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

512-Chassis, Rear Chassis, or Front
Chassis Fan not Detected

Chassis, rear chassis, or front chassis fan is
not connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.

514-CPU or Chassis Fan not Detected CPU or chassis fan is not connected or may
have malfunctioned.

1. Reseat CPU or chassis fan.

2. Reseat fan cable.

3. Replace CPU or chassis fan.

610-External Storage Device Failure External tape drive not connected. Reinstall tape drive or press F1 and allow
system to reconfigure without the drive.

611-Primary Floppy Port Address
Assignment Conflict

Configuration error. Run Computer Setup and check the
configuration in Advanced > Onboard
Devices.

660-Display cache is detected unreliable Integrated graphics controller display cache
is not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.

917-Front Audio Not Connected Front audio harness has been detached or
unseated from motherboard.

Reconnect or replace front audio harness.

918-Front USB Not Connected Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.

921-Device in PCI Express slot failed to
initialize

There is an incompatibility/problem with this
device and the system or PCI Express Link
could not be retrained to an x1.

Try rebooting the system. If the error
reoccurs, the device may not work with this
system

1151-Serial Port A Address Conflict
Detected

Both external and internal serial ports are
assigned to COM1.

1. Remove any serial port expansion
cards.

2. Clear CMOS.

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1152-Serial Port B Address Conflict
Detected

Both external and internal serial ports are
assigned to COM2.

1. Remove any serial port expansion
cards.

2. Clear CMOS.

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1155-Serial Port Address Conflict Detected Both external and internal serial ports are
assigned to same IRQ.

1. Remove any serial port expansion
cards.

2. Clear CMOS.

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1201-System Audio Address Conflict
Detected

Device IRQ address conflicts with another
device.

Enter Computer Setup and reset the IRQ in
Advanced > Onboard Devices.
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Table D-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

1202-MIDI Port Address Conflict Detected Device IRQ address conflicts with another
device.

Enter Computer Setup and reset the IRQ in
Advanced > Onboard Devices.

1203-Game Port Address Conflict Detected Device IRQ address conflicts with another
device.

Enter Computer Setup and reset the IRQ in
Advanced > Onboard Devices.

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1. Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System
test under Storage > DPS Self-test.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

1796-SATA Cabling Error One or more SATA devices are improperly
attached. For optimal performance, the
SATA 0 and SATA 1 connectors must be
used before SATA 2 and SATA 3.

Ensure SATA connectors are used in
ascending order. For one device, use SATA
0. For two devices, use SATA 0 and SATA
1. For three devices, use SATA 0, SATA1,
and SATA 2.

1797-SATA Drivelock is not supported in
RAID mode.

Drivelock is enabled on one or more SATA
hard drives, and they cannot be accessed
while the system is configured for RAID
mode.

Either remove the Drivelocked SATA device
or disable the Drivelock feature. To disable
the Drivelock feature, enter Computer
Setup, change Storage > Storage
Options > SATA Emulation to IDE, and
select File > Save Changes and Exit.
Reenter Computer Setup and select
Security > Drivelock. For each listed
Drivelock-capable SATA device, ensure
Drivelock is Disabled. Lastly, change
Storage > Storage Options > SATA
Emulation back to RAID and select File >
Save Changes and Exit.

1801-Microcode Patch Error Processor is not supported by ROM BIOS. 1. Upgrade BIOS to proper version.

2. Change the processor.

Invalid Electronic Serial Number Electronic serial number has become
corrupted.

1. Run Computer Setup. If Setup already
has data in the field or will not allow
the serial number to be entered,
download from http://www.hp.com.

2. Run Computer Setup and try to enter
serial number under Security, System
ID, then save changes.

Memory Parity Error Parity RAM failure.

Third-party graphics card may be causing a
problem.

Run Computer Setup and Diagnostic
utilities. Remove third-party graphics card to
see if the problem goes away.
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Table D-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

Network Server Mode Active and No
Keyboard Attached

Keyboard failure while Network Server
Mode enabled.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure. Third-party graphics
card may be causing a problem.

Run Computer Setup and Diagnostic
utilities. Remove third-party graphics card to
see if the problem goes away.

The system is violating the thermal
environment requirement.

Improper processor installed or add-in card
installed in 50C mode.

1. Replace the processor with a 65-W
processor.

2. Remove any add-in cards.
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Interpreting POST Diagnostic Front Panel LEDs and
Audible Codes

This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Look for the LED between the DIMM sockets. If the LED is illuminated, the system still has power.
Power off the computer and remove the power cord before proceeding.

NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of
the computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be
performed.

Not all diagnostic lights and audible codes are available on all models.

Table D-2  Diagnostic Front Panel LEDs and Audible Codes

Activity Beeps Possible Cause Recommended Action

Green Power LED On. None Computer on. None

Green Power LED flashes
every two seconds.

None Computer in Suspend to
RAM mode (some models
only) or normal Suspend
mode.

None required. Press any key or move the
mouse to wake the computer.

Red Power LED flashes two
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

2 Processor thermal
protection activated:

A fan may be blocked or
not turning.

OR

The heatsink/fan
assembly is not properly
attached to the processor.

1. Ensure that the computer air vents are not
blocked and the processor cooling fan is
running.

2. Open hood, press power button, and see if
the processor fan spins. If the processor fan
is not spinning, make sure the fan's cable is
plugged onto the system board header.

3. If fan is plugged in, but is not spinning, then
replace heatsink/fan assembly.

4. Contact an authorized reseller or service
provider.

Red Power LED flashes three
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

3 Processor not installed
(not an indicator of bad
processor).

1. Check to see that the processor is present.

2. Reseat the processor.
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Table D-2  Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes four
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

4 Power failure (power
supply is overloaded).

1. Open the hood and ensure the 4 or 6-wire
power supply cable is seated into the
connector on the system board.

2. Check if a device is causing the problem by
removing ALL attached devices (such as
hard, diskette, or optical drives, and
expansion cards). Power on the system. If
the system enters the POST, then power off
and replace one device at a time and
repeat this procedure until failure occurs.
Replace the device that is causing the
failure. Continue adding devices one at a
time to ensure all devices are functioning
properly.

3. Replace the power supply.

4. Replace the system board.

Red Power LED flashes five
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

5 Pre-video memory error. CAUTION: To avoid damage to the DIMMs or
the system board, you must unplug the computer
power cord before attempting to reseat, install, or
remove a DIMM module.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the
faulty module.

3. Replace third-party memory with HP
memory.

4. Replace the system board.

Red Power LED flashes six
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

6 Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace
the system board.

Red Power LED flashes
seven times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but LEDs
continue until problem is
solved.

7 System board failure
(ROM detected failure
prior to video).

Replace the system board.

Red Power LED flashes eight
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

8 Invalid ROM based on
bad checksum.

1. Reflash the system ROM with the latest
BIOS image. See the “Boot Block
Emergency Recovery Mode” section of the
Desktop Management Guide on the
Documentation and Diagnostics CD for
more information.

2. Replace the system board.
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Table D-2  Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes nine
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

9 System powers on but is
unable to boot.

1. Check that the voltage selector, located on
the rear of the power supply (some
models), is set to the appropriate voltage.
Proper voltage setting depends on your
region.

2. Replace the system board.

3. Replace the processor.

Red Power LED flashes ten
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

10 Bad option card. 1. Check each option card by removing the
card (one at a time if multiple cards), then
power on the system to see if fault goes
away.

2. Once a bad card is identified, remove and
replace the bad option card.

3. Replace the system board.
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Table D-2  Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Power LED flashes 12 times,
once every second, followed
by a two second pause.
Beeps stop after third iteration
and the computer reboots.

12 Health timer expired. None.

System does not power on
and LEDs are not flashing.

None System unable to power
on.

Press and hold the power button for less than 4
seconds. If the hard drive LED turns green, the
power button is working correctly. Try the
following:

1. Check that the voltage selector (some
models), located on the rear of the power
supply, is set to the appropriate voltage.
Proper voltage setting depends on your
region.

2. Replace the system board.

OR

Press and hold the power button for less than 4
seconds. If the hard drive LED does not turn on
green then:

1. Check that the unit is plugged into a
working AC outlet.

2. Open hood and check that the power button
harness is properly connected to the
system board.

3. Check that both power supply cables are
properly connected to the system board.

4. Check to see if the 5V_aux light on the
system board is turned on. If it is turned on,
then replace the power button harness. If
the problem persists, replace the system
board.

5. If the 5V_aux light on the system board is
not turned on, remove the expansion cards
one at a time until the 5V_aux light on the
system board turns on. It the problem
persists, replace the power supply.
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E Password Security and Resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.

This computer supports two security password features that are established through the Computer
Setup Utilities menu: setup password and power-on password. When you establish only a setup
password, any user can access all the information on the computer except Computer Setup. When
you establish only a power-on password, the power-on password is required to access Computer
Setup and any other information on the computer. When you establish both passwords, only the
setup password will give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to
the information on the computer by resetting the password jumper.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Backup is
performed through Computer Setup. See Computer Setup (F10) Utility on page 45 for information on
backing up the CMOS settings.
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Resetting the Password Jumper
To reset the power-on or setup passwords, complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the access panel.

4. Locate the header and jumper labeled PSWD on the system board.

NOTE: The password jumper is green so that it can be easily identified. For assistance
locating the password jumper and other system board components, see the Illustrated Parts &
Service Map (IPSM). The IPSM can be downloaded from http://www.hp.com/support.

5. Remove the jumper from the header.

6. Replace the jumper.

7. Replace the access panel.

8. Reconnect the external equipment.

9. Plug in the computer and turn on power. Allow the operating system to start. This clears the
current passwords and disables the password features.

10. Establish the new passwords in Computer Setup. Refer to Computer Setup (F10) Utility
on page 45 for Computer Setup instructions.
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Clearing and Resetting the CMOS
The computer’s configuration memory (CMOS) stores information about the computer’s configuration.

The CMOS button resets CMOS but does not clear the power-on and setup passwords.

Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management
Engine BIOS Extension (MEBx), including the password. The password will default to “admin” and will
need to be reset. The AMT settings will also need to be reset. To access the MEBx, press Ctrl+P
during POST.

1. Turn off the computer and any external devices, and disconnect the power cord from the power
outlet.

2. Disconnect the keyboard, monitor, and any other external equipment connected to the computer.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the access panel.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is
important to back up the computer CMOS settings before resetting them in case they are
needed later. Back up is easily done through Computer Setup. See Computer Setup (F10) Utility
on page 45 for information on backing up the CMOS settings.
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4. Locate, press, and hold the CMOS button in for five seconds.

NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS
button will not clear CMOS if the power cord is connected.

Figure E-1  CMOS button

NOTE: For assistance locating the CMOS button and other system board components, see the
Illustrated Parts & Service Map (IPSM) for that particular system.

5. Replace the access panel.

6. Reconnect the external devices.

7. Plug in the computer and turn on power.

NOTE: You will receive POST error messages after clearing CMOS and rebooting advising
you that configuration changes have occurred. Use Computer Setup to reset any special system
setups along with the date and time.

For instructions on Computer Setup, see Computer Setup (F10) Utility on page 45.
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F Troubleshooting Without Diagnostics

This chapter provides information on how to identify and correct minor problems, such as USB
devices, hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter
problems with the computer, refer to the tables in this chapter for probable causes and recommended
solutions.

NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to Appendix A, POST Error Messages on page 65.

Safety and Comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. For more information, refer to the Safety & Regulatory Information guide.

Before You Call for Technical Support
If you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.

● Run the HP diagnostic tool.

● Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility
on page 45 for more information.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to Appendix A, POST Error
Messages on page 65 for more information.

● If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Or, replace the monitor with a monitor that you know is functioning properly.

● If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and see if the computer functions
properly.

● If you recently installed new software, uninstall the software and see if the computer functions
properly.

● Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”
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● Refer to the comprehensive online technical support at http://www.hp.com/support.

● Refer to Helpful Hints on page 81 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional
Edition's online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/
go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers
and HP experts.

If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:

● Be in front of your computer when you call.

● Write down the computer serial number, product ID number, and monitor serial number before
calling.

● Spend time troubleshooting the problem with the service technician.

● Remove any hardware that was recently added to your system.

● Remove any software that was recently installed.

● Restore the system from the Recovery Disc Set that you created or restore the system to its
original factory condition in System Software Requirement Disks (SSRD).

CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data
files before running the restore process.

NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized
service provider or dealer.

Helpful Hints
If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

● Check that the computer and monitor are plugged into a working electrical outlet.

● Check that the voltage select switch (some models) is set to the appropriate voltage for your
region (115V or 230V).

● Check that the computer is turned on and the green power light is on.

● Check that the monitor is turned on and the green monitor light is on.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to Appendix A, POST Error
Messages on page 65 for more information.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● Press and hold any key. If the system beeps, then the keyboard should be operating correctly.

● Check all cable connections for loose connections or incorrect connections.
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● Wake the computer by pressing any key on the keyboard or pressing the power button. If the
system remains in suspend mode, shut down the computer by pressing and holding the power
button for at least four seconds then press the power button again to restart the computer. If the
system will not shut down, unplug the power cord, wait a few seconds, then plug it in again. The
computer will restart if it is set to power on automatically as soon as power is restored in
Computer Setup. If it does not restart, press the power button to start the computer.

● Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving Hardware Installation Problems on page 103 for instructions.

● Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

● Remove all bootable media (CD/DVD or USB device) from the system before turning it on.

● If you have installed an operating system other than the factory-installed operating system,
check to be sure that it is supported on the system.

● If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed
(embedded video on some models only) and a single monitor, the monitor must be plugged into
the monitor connector on the source selected as the primary VGA adapter. During boot, the
other monitor connectors are disabled and if the monitor is connected into these ports, the
monitor will not function. You can select which source will be the default VGA source in
Computer Setup.

CAUTION: When the computer is plugged into an AC power source, there is always voltage applied
to the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.
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Solving General Problems
You may be able to easily resolve the general problems described in this section. If a problem
persists and you are unable to resolve it yourself or if you feel uncomfortable about performing the
operation, contact an authorized dealer or reseller.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Table F-1  Solving General Problems

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four
seconds until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.

Cause Solution

Computer is in Sleep state. To resume from Sleep state, press the power button.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

System has locked up. Restart computer.

Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet
prolongs the life of the RTC battery.

Reset the date and time under Control Panel (Computer
Setup can also be used to update the RTC date and time). If
the problem persists, replace the RTC battery. See the
Removal and Replacement section for instructions on
installing a new battery, or contact an authorized dealer or
reseller for RTC battery replacement.

To access Control Panel in Windows 7, select Start, and
then select Control Panel.
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Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key is turned on. Press the Num Lock key. The Num Lock light must be off if
you want to use the arrow keys on the keypad. You can also
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.

There is no sound or sound volume is too low.

Cause Solution

System volume may be set low or muted. 1. Check the Computer Setup settings to make sure the
internal system speaker is not muted (this setting does
not affect the external speakers).

2. Make sure the external speakers are properly
connected and powered on and that the speakers'
volume control is set correctly.

3. Use the system volume control available in the
operating system to make sure the speakers are not
muted or to increase the volume.

Cannot remove computer cover or access panel.

Cause Solution

Smart Cover Lock, featured on some computers, is locked. Unlock the Smart Cover Lock using Computer Setup.

In case of forgotten password, power loss, or computer
malfunction, you must manually disable the Smart Cover
lock . A key to unlock the Smart Cover Lock is not available
from HP. Keys are typically available from a hardware store.

Poor performance.

Cause Solution

Processor is too hot. 1. Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on
the hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.

Program previously accessed did not release reserved
memory back to the system.

Restart the computer.
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Table F-1  Solving General Problems (continued)

Poor performance.

Cause Solution

Virus resident on the hard drive. Run virus protection program.

Too many applications running. Windows 7:

1. Close unnecessary applications to free up memory.

2. Add more memory.

3. Some applications run in the background and can be
closed by right-clicking on their corresponding icons in
the task tray. To prevent these applications from
launching at startup:

In Windows 7:

a. Go to Start > All Programs > Accessories > Run

b. Type msconfig, and then press Enter.

c. On the Startup tab of the System Configuration
Utility, clear applications that you do not want to
launch automatically, and the click OK.

Some software applications, especially games, are stressful
on the graphics subsystem.

1. Lower the display resolution for the current application
or consult the documentation that came with the
application for suggestions on how to improve
performance by adjusting parameters in the application.

2. Add more memory.

3. Upgrade the graphics solution.

Cause unknown. Restart the computer.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing).

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open the access panel, press the power button, and
see if the processor fan (or other system fan) spins. If
the fan does not spin, make sure the fan cable is
plugged onto the system board header.

3. If fan a plugged in and not spinning, replace it.
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System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If
the hard drive LED turns green, then:

1. If equipped with a voltage selector, check that the
voltage selector (located on the rear of the power
supply) is set to the appropriate voltage. Proper voltage
setting depends on your region.

2. Remove the expansion cards one at a time until the
5V_aux light on the system board turns on.

3. Replace the system board.

OR

Press and hold the power button for less than 4 seconds. If
the hard drive LED does not turn on green then:

1. Check that the unit is plugged into a working AC outlet.

2. Open the access panel and check that the power button
cable is properly connected to the system board.

3. Check that the power supply cables are properly
connected to the system board.

4. Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power
button assembly.

5. If the 5V_aux light on the system board is off, then
replace the power supply.

6. Replace the system board.
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Solving Power Problems
Common causes and solutions for power problems are listed in the following table.

Table F-2  Solving Power Problems

Power supply shuts down intermittently.

Cause Solution

If equipped with a voltage selector, voltage selector switch
on rear of computer chassis (some models) not switched to
correct line voltage (115V or 230V).

Select the proper AC voltage using the selector switch.

Power supply will not turn on because of internal power
supply fault.

Replace the power supply.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open the access panel, press the power button, and
see if the processor fan (or other system fan) spins. If
the fan does not spin, make sure the fan cable is
plugged onto the system board header.

3. If fan a plugged in and not spinning, replace it.
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Power LED flashes Red four times, once every second, followed by a two second pause, and the computer beeps
four times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Power failure (power supply is overloaded). 1. If equipped with a voltage selector, check that the
voltage selector, located on the rear of the power supply
(some models), is set to the appropriate voltage. Proper
voltage setting depends on your region.

2. Open the access panel and ensure the power supply
cable is seated into the connector on the system board.

3. Check if a device is causing the problem by removing
ALL attached devices (such as hard drives or optical
drives and expansion cards). Power on the system. If
the system enters POST, then power off and replace
one device at a time and repeat this procedure until
failure occurs. Replace the device that is causing the
failure. Continue adding devices one at a time to ensure
all devices are functioning properly.

4. Replace the power supply.

5. Replace the system board.

The incorrect external power supply adapter is being used on
the All-in One or USDT.

The power supply adapter must be at the correct power
rating and use the Smart ID technology before the system
will power up. Replace the power supply adapter with the
HP-supplied power supply adapter.
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Solving Hard Drive Problems

Table F-3  Solving Hard Drive Problems

Hard drive error occurs.

Cause Solution

Hard disk has bad sectors or has failed. 1. In Windows 7, click Start, click Computer, and right-
click on a drive. Select Properties, and then select the
Tools tab. Under Error-checking click Check Now.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.

Cause Solution

Either the directory structure is bad or there is a problem with
a file.

In Windows 7, click Start, expand Computer, and right-click
on a drive. Select Properties, and then select the Tools tab.
Under Error-checking click Check Now.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 103 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On Options.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

Nonsystem disk/NTLDR missing message.

Cause Solution

The system is trying to start from the hard drive but the hard
drive may have been damaged.

1. Perform Drive Protection System (DPS) testing in
system ROM.
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Table F-3  Solving Hard Drive Problems (continued)

Nonsystem disk/NTLDR missing message.

Cause Solution

System files missing or not properly installed. 1. Insert bootable media and restart the computer.

2. Boot to the windows installation media and select the
recovery option. If only a restore kit is available, then
select the File Backup Program option, and then
restore the system.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup. Run the Computer Setup utility and enable the hard drive
entry in the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard
drive configuration.

If attempting to boot from a hard drive, ensure it is attached
to the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order. Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive is listed
immediately under the Hard Drive entry.

Computer will not boot from hard drive.

Cause Solution

The device is attached to a SATA port that has been hidden
in Computer Setup.

1. Check SATA cable connections.

2. Run the Computer Setup utility and ensure Device
Available is selected for the device's SATA port in
Security > Device Security.

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage  > Boot Order.

Hard Drive's “Emulation Type” is set to “None.” (some
models)

Run the Computer Setup utility and change the “Emulation
Type” to “Hard Disk” in the device's details under Storage >
Device Configuration.

Hard drive is damaged. Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See Appendix A, POST Error
Messages on page 65 to determine possible causes for the
blinking red and beep codes.

See the Worldwide Limited Warranty for terms and
conditions.

Computer seems to be locked up.

Cause Solution

Program in use has stopped responding to commands. 1. Use the task manager to close programs that do not
respond.

2. Attempt the normal Windows “Shut Down” procedure. If
this fails, press the power button for four or more
seconds to turn off the power. To restart the computer,
press the power button again.
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Solving Media Card Reader Problems

Table F-4  Solving Media Card Reader Problems

Media card will not work in a digital camera after formatting it in Windows.

Cause Solution

By default, Windows will format any media card with a
capacity greater than 32MB with the FAT32 format. Some
digital cameras use the FAT (FAT16 & FAT12) format and
can not operate with a FAT32 formatted card.

Either format the media card in the digital camera or select
FAT file system to format the media card in a computer with
Windows.

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’s documentation included with your
card to see if it writable. Refer to the previous section for a
list of compatible cards.

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution

The media card is not inserted properly, is inserted in the
wrong slot, or is not supported.

Ensure that the card is inserted properly with the gold
contact on the correct side. The green LED will light if
inserted properly.
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Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. In Windows 7, click Start, select Computer, right-click on the
corresponding drive icon, and then select Eject. Pull the card
out of the slot.

NOTE: Never remove the card when the green LED is
flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized
by the computer.

Cause Solution

The operating system needs time to recognize the device if
the reader was just installed into the computer and you are
turning the PC on for the first time.

Wait a few seconds so that the operating system can
recognize the reader and the available ports, and then
recognize the media inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause Solution

The inserted media card has boot capability. 1. If you do not want to boot from the media card, remove
it during boot or do not select the option to boot from the
inserted media card during the boot process.

2. During POST (Power On Self-Test), press F9 to modify
the boot menu.

3. Change the boot sequence in F10 Computer Setup.
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Solving Display Problems
If you encounter display problems, see the documentation that came with the monitor and to the
common causes and solutions listed in the following table.

Table F-5  Solving Display Problems

Blank screen (no video).

Cause Solution

Monitor is not turned on and the monitor light is not on. Turn on the monitor and check that the monitor light is on.

Bad monitor. Try a different monitor.

The cable connections are not correct. Check the cable connection from the monitor to the computer
and to the electrical outlet.

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and type your
password (if set).

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal
scan rate as the resolution chosen.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Monitor cable is plugged into the wrong connector. Systems may have a monitor connection on both the
motherboard or an add-in card. Try moving the monitor
connection to a different connector on the back of the
computer

Monitor settings in the computer are not compatible with the
monitor.

1. In Control Panel, select Category from the View by list,
then under Appearance and Personalization, select
Adjust screen resolution.

To access Control Panel in Windows 7, click Start, and
then select Control Panel.

2. Expand the Resolution box, and then use the sliding
control to reset the resolution.

Monitor is configured to use an input that is not active. Use the monitor's on-screen menu controls to select the
input that is being driven by the system. Refer to the
monitor's user documentation for more information on the on-
screen controls and settings.
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Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and
the computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and
the computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card (if applicable). Power on the
system.

2. Replace the graphics card (if applicable).

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and
the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.

Cause Solution

The brightness and contrast controls are not set properly. Adjust the monitor brightness and contrast controls.

Cables are not properly connected. Check that the graphics cable is securely connected to the
graphics card (if applicable) or video connector and the
monitor.
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Blurry video or requested resolution cannot be set.

Cause Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution. Change requested resolution.

Graphics card is bad. Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.

Cause Solution

The monitor connections may be incomplete or the monitor
may be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
computer.

2. In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them
apart.

3. Fluorescent lights or fans may be too close to the
monitor.

Monitor needs to be degaussed. Degauss the monitor. Refer to the documentation that came
with the monitor for instructions.

Image is not centered.

Cause Solution

Position may need adjustment. Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the
image.

“No Connection, Check Signal Cable” displays on screen.

Cause Solution

Monitor video cable is disconnected. Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.
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“Out of Range” displays on screen.

Cause Solution

Video resolution and refresh rate are set higher than what
the monitor supports.

Restart the computer and enter Safe Mode. Change the
settings to a supported setting then restart the computer so
that the new settings take effect.

To enter Safe Mode in Windows 7:

1. Restart the computer.

2. Press and hold the F8 key as your computer restarts,
before the Windows logo appears. If the Windows logo
appears, you must restart the computer and try again.

3. On the Advanced Boot Options screen, use the arrow
keys to highlight the safe mode option you want, and
then press Enter.

4. Log on to your computer with a user account that has
administrator rights.

When your computer is in safe mode, Safe Mode
displays in the corners of your monitor. To exit safe
mode, restart your computer and let Windows start
normally.

High pitched noise coming from inside a flat panel monitor.

Cause Solution

Brightness and/or contrast settings are too high. Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to
center the picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause Solution

Flat panel monitor’s internal digital conversion circuits may
be unable to correctly interpret the output synchronization of
the graphics card.

1. Select the monitor’s Auto-Adjustment option in the
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions. To download a SoftPaq that
will assist you with the synchronization, go to the
following Web site, select the appropriate monitor, and
download either SP32347 or SP32202:
http://www.hp.com/support

Graphics card is not seated properly or is bad (some
models).

1. Reseat the graphics card.

2. Replace the graphics card.

96 Appendix F   Troubleshooting Without Diagnostics

http://www.hp.com/support


Certain typed symbols do not appear correct.

Cause Solution

The font you are using does not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. You can copy the symbol from the Character Map
into a document.

In Windows 7, click Start, select All Programs, select
Accessories, select System Tools, and then select
Character Map.
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Solving Audio Problems
If the computer has audio features and you encounter audio problems, see the common causes and
solutions listed in the following table.

Table F-6  Solving Audio Problems

Sound cuts in and out.

Cause Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause Solution

Software volume control is turned down or muted. Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.

Audio is hidden in Computer Setup. Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on. Turn on the external speakers.

The audio device may be connected to the wrong jack. Ensure that the device is connected to the correct jack on the
computer. The rear audio jack output is the green receptacle.
The speakers should be plugged into the line-out jack and
the headphones should be plugged into the headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection. The rear audio jack output is the green
receptacle.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Internal speaker is disabled in Computer Setup. Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.
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Sound from headphones is not clear or muffled.

Cause Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones into the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause Solution

The hard disk may be full. Before recording, make sure there is enough free space on
the hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the
jack or set the jack to its default value.

There is no sound or sound volume is too low.

Cause Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Solving Printer Problems
If you encounter printer problems, see the documentation that came with the printer and to the
common causes and solutions listed in the following table.

Table F-7  Solving Printer Problems

Printer will not print.

Cause Solution

Printer is not turned on and online. Turn the printer on and make sure it is online.
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Table F-7  Solving Printer Problems (continued)

Printer will not print.

Cause Solution

The correct printer drivers for the application are not
installed.

1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\ > [printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

To run MS-DOS commands, press the Windows key + r, type
cmd in the Open box, and then click OK.

If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on.

Cause Solution

The cables may not be connected properly. Reconnect all cables and check the power cord and
electrical outlet.

Printer prints garbled information.

Cause Solution

The correct printer driver for the application is not installed. Install the correct printer driver for the application.

The cables may not be connected properly. Reconnect all cables.

Printer memory may be overloaded. Reset the printer by turning it off for one minute, then turn it
back on.

Printer will not print.

Cause Solution

The printer may be out of paper. Check the paper tray and refill it if it is empty.
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Solving Keyboard and Mouse Problems
If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.

Table F-8  Solving Keyboard Problems

A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement, jumpy mouse/
keyboard, or no function of mouse/keyboard and external drive.

Cause Solution

If your computer is equipped with USB 3.0 ports, connected
USB 3.0 devices can interfere with the wireless keyboard
USB receiver.

Connect the wireless keyboard USB receiver to a USB 2.0
port that is separated from ports with USB 3.0 devices. If you
still experience interference, you may have to place the
connectors farther apart using an external USB hub.

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. Shut down the computer, reconnect the keyboard to the back
of the computer, and then restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart
the computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep date,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key is on. Press the Num Lock key. The Num Lock light should be off if
you want to use the arrow keys on the keypad. You can
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.
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Table F-9  Solving Mouse Problems

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.

Windows 7:

1. Press the Ctrl and Esc keys at the same time (or press
the Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then
press Enter.

3. After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Program in use has stopped responding to commands. Shut down the computer using the keyboard then restart the
computer.

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and
clean the internal components with a mouse cleaning kit
available from most computer stores.
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Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non-plug and play device, you must reconfigure
the computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.

To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Table F-10  Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause Solution

Device is not seated or connected properly. Ensure that the device is properly and securely connected
and that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on. Turn off the computer, turn on the external device, then turn
on the computer to integrate the device with the computer
system.

When the system advised you of changes to the
configuration, you did not accept them.

Reboot the computer and follow the instructions for
accepting the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > USB Security.
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Computer will not start.

Cause Solution

Wrong memory modules were used in the upgrade or
memory modules were installed in the wrong location.

1. Review the documentation that came with the system to
determine if you are using the correct memory modules
and to verify the proper installation.

NOTE: DIMM1 or XMM1 must always be installed. On
all computers except the USDT, DIMM1 must be
installed before DIMM2, and DIMM3 must be installed
before DIMM4.

2. Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for
specific problems.

3. If you still cannot resolve the issue, contact Customer
Support.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

NOTE: DIMM1 or XMM1 must always be installed. On
all computers except the USDT, DIMM1 must be
installed before DIMM2, and DIMM3 must be installed
before DIMM4

3. Replace third-party memory with HP memory.

4. Replace the system board.

Power LED flashes Red six times, once every second, followed by a two second pause, and the computer beeps six
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Graphics card (some models) is not seated properly or is
bad, or system board is bad.

For systems with a graphics card:

1. Reseat the graphics card. Power on the system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.
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Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer beeps ten
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Bad option card. 1. Check each option card by removing the cards one at
time (if multiple cards), then power on the system to see
if fault goes away.

2. Once bad card is identified, remove and replace bad
option card.

3. Replace the system board.

Solving Network Problems
Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.

Table F-11  Solving Network Problems

Wake-on-LAN feature is not functioning.

Cause Solution

S5 Maximum Power Saving feature is enabled. Disable the S5 Maximum Power Saving option in Computer
Setup. Select Power > Hardware Power Management > S5
Maximum Power Savings.

S5 Wake on LAN is disabled (some models). Enable the S5 Wake on LAN option in Computer Setup.
Select Advanced > Device Options > S5 Wake on LAN.

Wake-on-LAN is not enabled. To enable Wake-on-LAN in Windows 7:

1. Select Start > Control Panel > Network and Sharing
Center.

2. Under Tasks, select Manage network connections.

3. Click Local Area Connection.

4. Click the Properties button.

5. Click the Configure button.

6. Click the Power Management tab, then select Allow
this device to wake the computer.
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Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
using Device Manager.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

Incorrect network driver. Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer’s Web
site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

No active network is detected. Check cabling and network equipment for proper connection.

Network controller is not set up properly. Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
using Device Manager.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

Network driver is not properly loaded. Reinstall network drivers.

System cannot autosense the network. Disable auto-sensing capabilities and force the system into
the correct operating mode.

Diagnostics reports a failure.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector. Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other
end of the cable.

Ensure that the cable and device at the other end are
operating correctly.
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Table F-11  Solving Network Problems (continued)

Diagnostics reports a failure.

Cause Solution

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller is defective. Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer. Select the Network and Sharing Center icon in the Control
Panel and configure the network controller.

To access Control Panel in Windows 7, click Start, and then
select Control Panel.

Network controller stopped working when an expansion board was added to the computer.

Cause Solution

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires drivers. Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers using the Recovery Disc Set.

If necessary, download the softpaq from the web (from a
different computer).

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective. Contact an authorized service provider.
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New network card will not boot.

Cause Solution

New network card may be defective or may not meet
industry-standard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving Memory Problems
If you encounter memory problems, some common causes and solutions are listed in the following
table.

CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending
on the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you
must unplug the computer power cord before attempting to reseat, install, or remove a memory
module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC
memory. Otherwise, the computer will not boot the operating system.

NOTE: The memory count will be affected by configurations with the Management Engine (ME)
enabled. The ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-
channel mode to download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-
party data storage, and other management functions.

Table F-12  Solving Memory Problems

System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the DIMM1 or XMM1
socket.

Ensure that a memory module is installed in the DIMM1 or
XMM1 socket on the system board. This socket must be
populated with a memory module.

Memory module is not the correct type or speed grade for
the system or the new memory module is not seated
properly.

Replace module with the correct industry-standard device for
the computer. On some models, ECC and non-ECC memory
modules cannot be mixed.
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Out of memory error.

Cause Solution

You have run out of memory to run the application. Check the application documentation to determine the
memory requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed
correctly and that proper modules are used.

Integrated graphics may use system memory. No action required.

Insufficient memory error during operation.

Cause Solution

Too many Terminate and Stay Resident programs (TSRs)
are installed.

Delete any TSRs that you do not need.

You have run out of memory for the application. Check the memory requirements for the application or add
more memory to the computer.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving Processor Problems
If you encounter processor problems, common causes and solutions are listed in the following table.
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Table F-13  Solving Processor Problems

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure the airflow to the computer is not blocked.

2. Make sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.

Power LED flashes Red eleven times, once every second, followed by a two second pause.

Cause Solution

The current processor does not support a feature previously
enabled on this system.

1. Install a TXT (Trusted Execution Technology) capable
processor.

2. Disable TXT in the Computer Setup (F10) utility.

3. Reinstall the original processor.

Solving CD-ROM and DVD Problems
If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.

Table F-14  Solving CD-ROM and DVD Problems

System will not boot from CD-ROM or DVD drive.

Cause Solution

The device is attached to a SATA port that has been hidden
in the Computer Setup utility.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage  > Storage Options. Ensure
CD-ROM is enabled in Storage > Boot Order.

Network Boot is enabled in Computer Setup. Run the Computer Setup utility and disable Network Boot in
Security > Network Boot.
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Table F-14  Solving CD-ROM and DVD Problems (continued)

System will not boot from CD-ROM or DVD drive.

Cause Solution

Non-bootable CD in drive. Try a bootable CD in the drive.

Boot order not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 103 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced  >
Power-On Options.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause Solution

Drive is not connected properly or not properly configured. See the documentation that came with the optional device.

Movie will not play in the DVD drive.

Cause Solution

Movie may be regionalized for a different country. See the documentation that came with the DVD drive.

Decoder software is not installed. Install decoder software.

Damaged media. Replace media.

Movie rating locked out by parental lock. Use DVD software to remove parental lock.

Media installed upside down. Reinstall media.
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Cannot eject compact disc (tray-load unit).

Cause Solution

Disc not properly seated in the drive. Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray
out from the drive until the tray is fully extended, then remove
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause Solution

Media is corrupt. Try different media to confirm whether media is valid.

Media has been inserted upside down. Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive
determine the type of media being played. If the disc still
does not start, read the other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive. 1. Use Device Manager to remove or uninstall the device.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

2. Restart the computer and let Windows detect the CD or
DVD driver.

Recording or copying CDs is difficult or impossible.

Cause Solution

Wrong or poor quality media type. 1. Try using a slower speed when recording.

2. Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.
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Solving USB Flash Drive Problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.

Table F-15  Solving USB Flash Drive Problems

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and enable USB ports in
Security > USB Security.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
USB is enabled in Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause Solution

Flash drive is bootable. Install the flash drive only after the operating system boots.

Flash drive is defective. Try a different flash drive.

Solving USB Flash Drive Problems 113



Solving Front Panel Component Problems
If you encounter problems with devices connected to the front panel, refer to the common causes and
solutions listed in the following table.

A USB device, headphone, or microphone is not recognized by the computer.

Cause Solution

Device is not properly connected. 1. Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power. If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not installed. 1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work. 1. If possible, replace the cable.

2. Restart the computer.

The device is not working. 1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that the USB
ports are set to Enabled in Security > USB Security.

Solving Internet Access Problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Unable to connect to the Internet.

Cause Solution

Internet Service Provider (ISP) account is not set up
properly.

Verify Internet settings or contact your ISP for assistance.

Web browser is not set up properly. Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in. Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected. Connect the CAT5 UTP cable between the cable modem
and the computers’s RJ-45 connector. (If the connection is
good, the “PC” LED light on the front of the cable/DSL
modem will be on.)
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Unable to connect to the Internet.

Cause Solution

IP address is not configured properly. Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser
remember some specific information that the Web server can
later retrieve.)

Windows 7:

1. Select Start > Control Panel.

2. Click Internet Options.

3. In the Browsing history section on the General tab,
click the Delete button.

4. Select the Cookies check box and click the Delete
button.

Cannot automatically launch Internet programs.

Cause Solution

You must log on to your ISP before some programs will start. Log on to your ISP and launch the desired program.
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Solving Software Problems
Most software problems occur as a result of the following:

● The application was not installed or configured correctly.

● There is insufficient memory available to run the application.

● There is a conflict between applications.

● Be sure that all the needed device drivers have been installed.

● If you have installed an operating system other than the factory-installed operating system,
check to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Computer will not continue and the HP logo does not display.

Cause Solution

ROM issue - POST error has occurred. Observe the beeps and LED lights on the front of the
computer. See Appendix A, POST Error Messages
on page 65 to determine possible causes.

See the Worldwide Limited Warranty for terms and
conditions.

Computer will not continue after HP logo screen displays.

Cause Solution

System files may be damaged. In Windows 7, use recovery media to scan hard drive for
errors, or use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly. Windows
Startup Repair is one of the recovery tools in the System
Recovery Options menu. You can also create a system
repair disc that contains the System Recovery Options
menu. If the problem is severe enough that Startup Repair
doesn't start on its own and you can't access the System
Recovery Options menu on your computer's hard disk, you
can get to the menu and start Startup Repair by using the
Windows installation disc or a system repair disc that you
created earlier.

“Illegal Operation has Occurred” error message is displayed.

Cause Solution

Software being used is not Microsoft-certified for your
version of Windows.

Verify that the software is certified by Microsoft for your
version of Windows (see program packaging for this
information).

Configuration files are corrupt. If possible, save all data, close all programs, and restart the
computer.
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G Serial and Parallel ATA Drive
Guidelines and Features

NOTE: Serial ATA = SATA

Parallel ATA = PATA

HP only supports the use of SATA hard drives on these models of computer. No PATA drives are
supported on any of these models.

SATA Hard Drives

Serial ATA Hard Drive Characteristics  

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)

Data interface voltage differential 400-700 mV

Drive voltages 3.3 V, 5 V, 12 V

Jumpers for configuring drive N/A

Data transfer rate 3.0 Gb/s

SATA connectors on the system board are color coded to make identification easier.

SATA Identification Color Port Attachment Sequence

Primary channel, device 0 Dark blue SATA 0 1

Primary channel, device 1 Light Blue SATA 2 4

Secondary channel, device 0 White SATA 1 2

NOTE: If there is an error on the application of the attach rules, a POST error message may be
displayed.
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SATA Hard Drive Cables

SATA Data Cable

Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA
1.5 Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and
never bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive. As shown
in the table, each cable has 3 grounds, and 4 transmit/receive pins.

Pin Number Usage Device Plug Host Plug

P1 Ground Ground Ground

P2* A+ Transmit data Receive data

P3* A- Transmit data Receive data

P4 Ground Ground Ground

P5** B- Receive data Transmit data

P6** B+ Receive data Transmit data

P7 Ground Ground Ground

*P2 and P3 differential signal pair

**P5 and P6 differential signal pair

SATA Power Cable

Pin Usage Notes Pin Usage Notes

P1 V3.3 3.3 V power P9 V5 5 V power

P2 V3.3 3.3 V power P10 Ground

P3 V3.3 3.3 V power P11 Ground

P4 Ground P12 Ground

P5 Ground P13 V12 12 V power

P6 Ground P14 V12 12 V power

P7 V5 5 V power P15 V12 12 V power

P8 V5 5 V power
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PATA Device Information
No PATA drives are supported on any of the rp5800 models.

ATA SMART Drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Hard Drive Capacities
The combination of the file system and the operating system used in the computer determines the
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that may
be properly accessed by the operating system. A single hard drive may therefore be subdivided into a
number of unique drive partitions in order to make use of all of its space.

Because of the differences in the way that drive sizes are calculated, the size reported by the
operating system may differ from that marked on the hard drive or listed in the computer specification.
Drive size calculations by drive manufacturers are bytes to the base 10 while calculations by
Microsoft are bytes to the base 2.

Drive/Partition Capacity Limits

 Maximum Size

File System Controller Type Operating System Partition Drive

FAT 32 ATA Windows 7 32 GB 2 TB

NTFS ATA Windows 7 2 TB 2 TB
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H Identifying the Chassis, Routine Care,
and Disassembly Preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.
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Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the
discharge contains enough power to alter device parameters or melt silicon junctions.

Generating Static

The following table shows that:

● Different activities generate different amounts of static electricity.

● Static electricity increases as humidity decreases.

 Relative Humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

Removing DIPs* from plastic tube

7,500 V

3,000 V

400 V

400 V

15,000 V

5,000 V

800 V

700 V

35,000 V

12,000 V

6,000 V

2,000 V

Removing DIPs* from vinyl tray

Removing DIPs* from Styrofoam

Removing bubble pack from PCB

Packing PCBs in foam-lined box

2,000 V

3,500 V

7,000 V

5,000 V

4,000 V

5,000 V

20,000 V

11,000 V

11,500 V

14,500 V

26,500 V

21,000 V

*These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.

Preventing Electrostatic Damage to Equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the
degree of sensitivity. The following packaging and grounding precautions are necessary to prevent
damage to electric components and accessories.

● To avoid hand contact, transport products in static-safe containers such as tubes, bags, or
boxes.

● Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

● Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from their container.
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● Always be properly grounded when touching a sensitive component or assembly.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
conductive foam.

Personal Grounding Methods and Equipment

Use the following equipment to prevent static electricity damage to equipment:

● Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

● Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on
both feet with a maximum of one-megohm ± 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage

Antistatic plastic

Carbon-loaded plastic

Metallized laminate

1,500

7,500

15,000

Grounding the Work Area

To prevent static damage at the work area, use the following precautions:

● Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

● Turn off power and input signals before inserting and removing connectors or test equipment.

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative
surfaces.

● Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

● Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended Materials and Equipment

Materials and equipment that are recommended for use in preventing static electricity include:

● Antistatic tape

● Antistatic smocks, aprons, or sleeve protectors
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● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

● Static-dissipative table or floor mats with hard tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one-megohm +/- 10% resistance

● Material handling packages

● Conductive plastic bags

● Conductive plastic tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes

Operating Guidelines
To prevent overheating and to help prolong the life of the computer:

● Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and
cold.

● Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all
vented sides of the computer and above the monitor to permit the required airflow.

● Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

● Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

● Never operate the computer with the cover or side panel removed.

● Do not stack computers on top of each other or place computers so near each other that they
are subject to each other’s re-circulated or preheated air.

● If the computer is to be operated within a separate enclosure, intake and exhaust ventilation
must be provided on the enclosure, and the same operating guidelines listed above will still
apply.

● Keep liquids away from the computer and keyboard.
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● Never cover the ventilation slots on the monitor with any type of material.

● Install or enable power management functions of the operating system or other software,
including sleep states.

Routine Care

General Cleaning Safety Precautions

1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case

Follow all safety precautions in General Cleaning Safety Precautions on page 124 before cleaning
the computer.

To clean the computer case, follow the procedures described below:

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

● After cleaning, always wipe the unit with a clean, lint-free cloth.

● Occasionally clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the Keyboard

Follow all safety precautions in General Cleaning Safety Precautions on page 124 before cleaning
the keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 124.

When cleaning debris from under the keys, review all rules in General Cleaning Safety Precautions
on page 124 before following these procedures:
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CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.

● Visible debris underneath or between the keys may be removed by vacuuming or shaking.

● Canned, pressurized air may be used to clean debris from under the keys. Caution should be
used as too much air pressure can dislodge lubricants applied under the wide keys.

● If you remove a key, use a specially designed key puller to prevent damage to the keys. This
tool is available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these
keys are improperly removed or installed, the keyboard may not function properly.

● Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the Monitor

● Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

● To clean the monitor body follow the procedures in Cleaning the Computer Case on page 124.

Cleaning the Mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

● Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

● To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 124.

Service Considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Power Supply Fan

The power supply fan is a variable-speed fan based on the temperature in the power supply.

CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is
off when the computer is in “Standby,” “Suspend,” or “Off” modes.

You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.
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Tools and Software Requirements

To service the computer, you need the following:

● Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)

● Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

● Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

● Phillips #2 screwdriver

● Diagnostics software

● HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or HP tamper-
resistant bits (Smart Cover FailSafe Key, PN 166527-002)

Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with
the part that was removed, then returned to their proper locations.

CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard
drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.

Cables and Connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with
care to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot
be caught or snagged by parts being removed or replaced.

CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.

● If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

● Avoid dropping drives from any height onto any surface.

● If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.
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● Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic
damage, refer to Electrostatic Discharge Information on page 121

● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.

Lithium Coin Cell Battery

The battery that comes with the computer provides power to the real-time clock and has a minimum
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this
guide for instructions on the replacement procedures.

WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose
in water or fire, or expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the
battery.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, their authorized partners, or their agents.
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I Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch
feature on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts
AC. Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where
you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use
the computer.

General Requirements
The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for
evaluation in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a
nominal voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency  Country Accrediting Agency

Australia (1)

Austria (1)

Belgium (1)

Canada (2)

EANSW

OVE

CEBC

CSA

 Italy (1)

Japan (3)

Norway (1)

Sweden (1)

IMQ

METI

NEMKO

SEMKO

Denmark (1)

Finland (1)

France (1)

Germany (1)

DEMKO

SETI

UTE

VDE

 Switzerland (1)

United Kingdom (1)

United States (2)

SEV

BSI

UL

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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J Specifications

Desktop Dimensions

Height

Width

Depth

3.5 in

11.2 in

10.69 in

8.9 cm

28.5 cm

27.2 cm

Approximate Weight 7.98 lb 3.63 kg

Maximum Supported Weight 77.0 lb 35.0 kg

Temperature Range

Operating

Nonoperating

32° to 104°F

-22° to 149°F

0° to 40°C

-30° to 65°C

Relative Humidity (noncondensing)

Operating

Nonoperating

10-90%

0-95%

10-90%

0-95%

Maximum Altitude (unpressurized)

Operating

Nonoperating

10,000 ft

30,000 ft

3048 m

9.144m

Power Supply

Watts

Rated Voltage Range

Rated Line Frequency

Operating Line Frequency Range

Rated Input Current

Efficiency

Power Supply Fan

Power Cord Length

115-watt – EPA85 power supply

100-240 V

50-60 Hz

47 – 63 Hz

≤1.5A

82/85/82% at 20/50/100% load

50 mm variable speed fan

6.0ft (1.8 3m)

115-watt – EPA85 power supply

100-240 V

50-60 Hz

47 – 63 Hz

≤1.5A

82/85/82% at 20/50/100% load

50 mm variable speed fan

6.0ft (1.8 3m)

130 Appendix J   Specifications



Index

Symbols/Numerics
2-port powered serial card, spare

part number 10, 12, 22

A
access panel

spare part number 14, 16
access panel,

spare part number 7
access panel, locked 84
access panel, removal and

replacement 16
adapter, DisplayPort to DVI

spare part number 12
adapter, DisplayPort to DVI (not

illustrated)
spare part number 8

adapter, DisplayPort to HDMI
spare part number 12

adapter, DisplayPort to HDMI (not
illustrated)

spare part number 8
adapter, DisplayPort to VGA

spare part number 12
adapter, DisplayPort to VGA (not

illustrated)
spare part number 8

antenna kit for use with WLAN
modules, spare part number 9,
14

audible codes 72
audio connectors 2
audio problems 98

B
battery

disposal 127
battery replacement 34
beep codes 72

bezel, removal and replacement
17

booting options
Full Boot 65
Quick Boot 65

C
cable connections 19
cable management 18
cable pinouts

SATA data 118
SATA power 118

cash drawer connector 3
cautions

AC power 120
cables 126
cooling fan 125
electrostatic discharge 121
keyboard cleaning 125
keyboard keys 125

CD-ROM or DVD problems 110
chasis types, illustrated 120
cleaning

computer 124
mouse 125
safety precautions 124

CMOS
backing up 76
clearing and resetting 78

computer cleaning 124
connections

system board 19
country power cord set

requirements 129
cover, powered serial port, spare

part number 9, 11
Customer Support 80

D
disassembly preparation 15
DisplayPort 3
DisplayPort cable

spare part number 8, 11

E
electrostatic discharge (ESD)

121
preventing damage 121

error
codes 65, 72
messages 66

F
fan

spare part number 14
fan assembly

spare part number 9
fan, power supply 125
flash drive problems 113
flashing LEDs 72
front bezel

spare part number 7, 14, 17
front bezel, removal and

replacement 17
front fan

removal and replacement 38
spare part number 38

front panel components 2
front panel problems 114
front USB and power switch

removal and replacement 40
front USB and power switch

assembly
spare part number 8, 14, 40

G
general problems 83
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grounding methods 122

H
hard drive

proper handling 126
SATA characteristics 117
spare part numbers 10

hard drive grommet
spare part number 9, 11

hard drive power/data cable
assembly

spare part number 8, 14
hard drive problems 89
hard drive replacement 32
hardware installation problems

103
helpful hints 81

I
installing

12V Powered USB expansion
card 26

battery 34
hard drive 32
memory 20
powered serial port expansion

card 23
riser card 29

Internet access problems 114

K
keyboard

cleaning 124
spare part numbers 9, 12, 13

keyboard problems 101

L
LEDs

blinking power 72
blinking PS/2 keyboard 72

M
Media Card Reader problems 91
memory

installing 20
specifications 20

memory module
spare part number 20

memory modules
spare part number 7, 14

memory problems 108

monitor problems 93
mouse

spare part numbers 9
mouse cleaning 125
mouse problems 101

N
network activity light 2
network connector 3
network link light 2
network problems 105
numeric error codes 66

O
operating guidelines 123
optical drive problems 110
overheating, prevention 123

P
password

clearing 76
power-on 76
setup 76

PCIe to PCI Riser – 24V, spare
part number 14

PCIe to PCI riser – 24V, spare part
number 22

PCIe to PCI riser, spare part
number 10

POST error messages 65
power cord set requirements

country specific 129
power problems 87
power supply 130

fan 125
removal and replacement 42
spare part number 7, 14

power-on password 76
Powered USB Card – 12V, spare

part number 10, 14, 22
printer problems 99
problems

audio 98
CD-ROM or DVD 110
flash drive 113
front panel 114
general 83
hard drive 89
hardware installation 103
Internet access 114
keyboard 101

Media Card Reader 91
memory 108
monitor 93
mouse 101
network 105
power 87
printer 99
processor 109
software 116

processor problems 109
product ID location 3, 15
PS/2 connectors 3

R
Ralink RT5390R 802.11bgn 1x1

Wi-Fi Adapter (WLAN module),
spare part number 10, 22

rear panel components 3
removal and replacement

access panel 16
bezel 17
front bezel 17
front fan 38
front USB and power switch

40
power supply 42
speaker 41
system board 44

removal and replacement
procedures

WLAN module 36
removing

battery 34
hard drive 32

replacing
battery 34
hard drive 32
riser card 29

resetting
CMOS 76
password jumper 76

riser card
replacing 29

rubber feet, spare part number 9,
11

S
safety and comfort 80
safety precautions

cleaning 124
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SATA
connectors on system board

117
data cable pinouts 118
hard drive characteristics 117
power cable pinouts 118

screws, correct size 126
serial number location 3, 15
serial ports

configuring for power 25
installing expansion card 23
locations 23

service considerations 125
setup password 76
software

problems 116
servicing computer 126

solid-state drive, spare part
number 10, 12

spare part number
tamper-resistent wrench 126
Torx T-15 screwdriver 126

speaker
removal and replacement 41
spare part number 9, 12, 41

specifications
computer 130
memory 20

static electricity 121
system board

removal and replacement 44
SATA connectors 117
spare part number 7, 14, 44

T
tamper-proof screws

tool 126
temperature control 123
tools, servicing 126
Torx T15 screwdriver 126

U
USB

12V and 24V identification 26
12V Powered USB

installation 26
port locations 2, 3

V
ventilation, proper 123
VGA connector 3

W
Wake-on-LAN feature 105
WLAN module

removing 36
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